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1 ¢ Introduction

1.1 Introduction to lon Chromatography (IC)

The Thermo Scientific Dionex " 1CS-1100 lon Chromatography System (Dionex
ICS-1100) performs ion analyses using suppressed or non-suppressed
conductivity detection. An ion chromatography system typically consists of a
liquid eluent, a high-pressure pump, a sample injector, a guard and separator
column, a chemical suppressor, a conductivity cell, and a data collection system.

Before running a sample, the ion chromatography system is calibrated using a
standard solution. By comparing the data obtained from a sample to that obtained
from the known standard, sample ions can be identified and quantitated. The data
collection system, typically a computer running chromatography software,
produces a chromatogram (a plot of the detector output vs. time). The
chromatography software converts each peak in the chromatogram to a sample
concentration and produces a printout of the results.
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A typical IC analysis consists of six stages (see Figure 1-1).

6. Data Analysis

Conductvity |5 Detection

1. Eluent
Delivery

Separator
Column

Injection

Sample

2. Sample

Injection
Sample Loop

Figure 1-1. lon Analysis Process

1. Eluent Delivery

e Eluent, a liquid that helps to separate the sample ions, carries the
sample through the ion chromatography system. The Dionex ICS-
1100 is an isocratic delivery system. This means that the eluent
composition and concentration remain constant throughout the run.

2. Sample Injection

e The liquid sample is loaded into a sample loop either manually or
automatically (if an automated sampler is installed). When triggered,
the Dionex ICS-1100 injects the sample into the eluent stream.

e The pump pushes the eluent and sample through the guard and
separator columns (chemically-inert tubes packed with a polymeric
resin). The guard column removes contaminants that might poison the
separator column.
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3. Separation

* Asthe eluent and sample are pumped through the separator column,
the sample ions are separated. In the Dionex ICS-1100, the mode of
separation is called ion exchange. This is based on the premise that
different sample ions migrate through the IC column at different rates,
depending upon their interactions with the ion exchange sites.

4. Suppression

= After the eluent and sample ions leave the column, they flow through
a suppressor that selectively enhances detection of the sample ions
while suppressing the conductivity of the eluent.

5. Detection

= A conductivity cell measures the electrical conductance of the sample
ions as they emerge from the suppressor and produces a signal based
on a chemical or physical property of the analyte.

6. Data Analysis
* The conductivity cell transmits the signal to a data collection system.

e The data collection system (for the Dionex 1CS-1100, this is the
Chromeleon™ Chromatography Management System) identifies the
ions based on retention time, and quantifies each analyte by
integrating the peak area or peak height. The data is quantitated by
comparing the sample peaks in a chromatogram to those produced
from a standard solution. The results are displayed as a chromatogram
and the concentrations of ionic analytes can be automatically
determined and tabulated.

Doc. 065289-03 10/12 3
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1.2 Overview of the Dionex ICS-1100

The Dionex ICS-1100 is an integrated ion chromatography system containing a
pump, injection valve, and conductivity detector. Other system components,
including a guard column, separator column, and suppressor vary, depending on
the analyses to be performed.

The Dionex ICS-1100 can optionally be configured with a column heater for
temperature control of the column. An optional second high-pressure valve (6-
port or 10-port) can be installed for sample preparation applications.

The Dionex ICS-1100 contains a built-in ER Controller and pre-plumbed tubing
for operation in the RFIC-ER™ (Reagent-Free™ lon Chromatography with Eluent
Regeneration) mode. RFIC-ER technology uses the suppressor to regenerate
returning eluent, allowing a single batch of eluent to be used for up to four weeks.

Dionex ICS-1100 operation is controlled remotely by a personal computer
running Windows® Vista or Windows XP and Chromeleon software (version 6.80
SR6a or later). Chromeleon also provides data acquisition and data processing
functions.

For communication between the Dionex ICS-1100 and Chromeleon, the Dionex
ICS-1100 is connected to a USB (Universal Serial Bus) port on the computer or a
USB hub. For details, see the Dionex 1CS-1100 installation instructions. Also
refer to Installing the Chromeleon Chromatography Management System with a
Dionex lon Chromatograph (IC) (Document No. 031883).
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13

About This Manual

The electronic version (i.e., PDF file) of this operator’s manual contains numerous
hypertext links that can take you to other locations within the file. These links

include:

e Table of contents entries

e |ndex entries

e Cross-references (underlined in blue) to sections, figures, tables, etc.

If you are not familiar with how to navigate PDF files, refer to the Help system for
Adobe® Acrobat® or Adobe Reader® for assistance

Chapter 1
Introduction

Chapter 2
Features

Chapter 3
Operation and
Maintenance

Chapter 4
Troubleshooting

Chapter 5
Service

Appendix A
Specifications

Appendix B
TTL and Relay
Control

Appendix C
Reordering
Information

Appendix D
FAQ

Introduces ion analysis and the Dionex ICS-1100; explains
the conventions used in this manual, including safety-
related information.

Provides an overview of Dionex ICS-1100 operating
features and system components; introduces the
Chromeleon user interface.

Provides operating instructions and describes routine
preventive maintenance procedures.

Lists problems, and presents step-by-step procedures for
how to isolate and eliminate the cause of each problem.

Provides step-by-step instructions for routine service and
parts replacement procedures that the user can perform.

Lists the Dionex ICS-1100 specifications and installation
site requirements.

Describes the Dionex ICS-1100 TTL and relay control
features.

Lists spare parts for the Dionex 1CS-1100.

Provides answers to frequently asked questions about
Dionex 1CS-1100 operation.
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Appendix E Defines terms commonly used in ion analysis.
Glossary

1.3.1 Safety Messages and Notes

This manual contains warnings and precautionary statements that, when
properly followed, can prevent personal injury and/or damage to the
instrument. Safety messages appear in bold type and are accompanied by
icons, as shown below.

Indicates an imminently hazardous situation which, if not avoided, will
result in death or serious injury.

P>

DANGER

Indicates a potentially hazardous situation which, if not avoided,
could result in death or serious injury.

P>

WARNING

Indicates a potentially hazardous situation which, if not avoided, may
result in minor or moderate injury. Also used to identify a situation or

practice that may seriously damage the instrument, but will not cause
CAUTION injury.

P>

IMPORTANT] Indicates that the function or process of the instrument may be
impaired. Operation does not constitute a hazard.

Messages d'avertissement en francgais

Signale une situation de danger immeédiat qui, si elle n'est pas évitée,
entrainera des blessures graves a mortelles.

P>

DANGER

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entrainer des blessures graves a mortelles.

>

AVERTISSEMENT

Signale une situation de danger potentiel qui, si elle n'est pas évitée,
pourrait entrainer des blessures mineures a modérées. Egalement
utilisé pour signaler une situation ou une pratique qui pourrait
MISE EN GARDE gravement endommager l'instrument mais qui n'entrainera pas de
blessures.

>
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Warnhinweise in Deutsch

Bedeutet unmittelbare Gefahr. MiBachtung kann zum Tod oder
schwerwiegenden Verletzungen fuhren.

ACHTUNG
Bedeutet eine mdgliche Gefahrdung. MiBachtung kann zum Tod oder
schwerwiegenden Verletzungen fuhren.
WARNUNG
Bedeutet eine mogliche Gefahrdung. MifRachtung kann zu kleineren
oder mittelschweren Verletzungen fiihren. Wird auch verwendet, wenn
eine Situation zu schweren Schaden am Gerét fiihren kann, jedoch
VORSICHT

keine Verletzungsgefahr besteht.

Notes

Informational messages also appear throughout this manual. These are
labeled NOTE and are in bold type:

NOTE NOTES call attention to certain information. They
alert you to an unexpected result of an action,
suggest how to optimize instrument performance,
etc.

Doc. 065289-03 10/12 7
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1.4

Safety and Regulatory Information

The Dionex ICS-1100 was manufactured by Thermo Fisher Scientific at the
following location: 527 Lakeside Drive, Sunnyvale, CA 94088-3603 U.S.A. The
Dionex 1CS-1100 is designed for IC (ion chromatography) applications and
should not be used for any other purpose. Operation of a Dionex ICS-1100 in a
manner not specified by Thermo Fisher Scientific may result in personal injury. If
there is a question regarding appropriate usage, contact Technical Support for
Dionex products. In the U.S. and Canada, call 1-800-346-6390. Outside the U.S.
and Canada, call the nearest Thermo Fisher Scientific office.

14.1

Safety Labels

The TUV T-Mark and cTUVus Mark safety labels and the CE Mark label
on the system indicate that it is in compliance with the following
standards:

EMC Susceptibility and Emissions
e EN 61326-1:2006

Safety

e CAN/CSA-C22.2 61010-1:2004
e UL 61010-1:2004

e EN61010-1:2001

The symbols below appear on the Dionex ICS-1100 or on labels affixed to
the Dionex 1CS-1100.

~ Alternating current

@ Primary protective conductor terminal

J:— Secondary protective conductor terminal

Doc. 065289-03 10/12



1 « Introduction

Power supply is on

Power supply is off

Hot surface

Indicates a potential hazard. Refer to the operator’s manual for
an explanation of the hazard and how to proceed.

> e O -
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2 * Features

This chapter describes key Dionex 1CS-1100 features and introduces the

Chromeleon user interface.
2.1 Operating Features

2.1.1 Front Panel

Figure 2-1 illustrates the front panel of the Dionex 1CS-1100.

ELUENT
Status
LEDs

&
Injection /

Port

/ Compartment

Figure 2-1. Dionex ICS-1100 Front Panel

Injection Port

The sample to be analyzed can
be injected manually into the
injection port, using a syringe.
For automated sample
injection, the Dionex 1CS-1100
must be connected to an
autosampler. For more
information about sample
injection, see Section 3.10.

LEDs

The status LEDs (see

Figure 2-2) indicate the status
of various system functions.
See Table 2-1 for a description
of each LED’s function. The
power LED indicates whether
the Dionex 1CS-1100 power is
on.

Doc. 065289-03 10/12
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LED Label
Load

Inject

Alarm

Module
Connected

Acquiring
Data

Pump

Suppressor

Column
Heater

4 N\ /
INJECT VALVE STATUS

@ Load Module Connected

@ Inject @Acquiring Data
\ /

Pump
' Suppressor
ALARM
@ @ Column Heater

\. /.

Figure 2-2. Status LEDs

If On (Green)

Injection valve is in Load
position.

Injection valve is in Inject
position.

This LED does not have
an “on” (green) state.

Dionex ICS-1100 is
connected to a
Chromeleon timebase.

Sequence or manual data
acquisition is in progress.

Pump is on.

Suppressor is on and
current is being applied to
it.

Column heater is at set
temperature.

If Flashing

Valve error.

Valve error.

Error detected. Check the Chromeleon
Audit Trail for the cause.

Does not flash.

Sequence has stopped due to an error.

High or low pressure limit is exceeded.
The pump is turned off.

Continuity check failed or suppressor is
over the voltage, current, or power limit.
The suppressor is turned off.

Column heater is transitioning to a new
temperature.

Table 2-1. Dionex ICS-1100 Status LED States

12
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2.1.2 Top Cover

Figure 2-3 illustrates the top cover of the Dionex ICS-1100.

»
- , Eluent
/ Reservoir

< ”

Figure 2-3. Dionex ICS-1100 (Top View)

Reservoir Storage

The Dionex ICS-1100 top cover
has room for up to three 2-L
plastic reservoirs (P/N 044129)
or one 4-L plastic reservoir
(P/N 039164).

Tubing Chase
The tubing chase under the top

cover routes tubing to the front of
the Dionex 1CS-1100.

Doc. 065289-03 10/12
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2.1.3 Component Panel

Figure 2-4 shows the user-accessible components installed on the
component panel behind the Dionex ICS-1100 front door.

@ Pressure Transducer

e Leak Sensor

Pump Heads

Injection Valve

Site for Auxiliary Valve
(Optional)

DS6 Conductivity Cell
Suppressor

Column Heater
(Optional) and Columns

Eluent Valve

Mounting Brackets for
Second Suppressor

Tubing Chase (2)

& 6 6 ©6 00 600 O

Figure 2-4. Dionex ICS-1100 Component Panel
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Pressure Transducer

The pressure transducer measures the system backpressure.

Leak Sensor

The leak sensor is installed in the drip tray at the bottom of the component
panel. If liquid accumulates in the tray, an error message is logged in the
Chromeleon Audit Trail and the Alarm LED flashes.

Pump Heads

The Dionex ICS-1100 includes a dual-piston serial pump. The flow rate
can be set to 0.00 mL/min or to between 0.05 and 5.00 mL/min. However,
for optimum performance, set the flow rate to between 0.40 and

2.00 mL/min. Setting the flow rate to 0.00 mL/min turns off the pump.
See Section 2.4.3 for details about the pump.

Injection Valve

The injection valve is a six-port, electrically-activated Rheodyne valve. A
25-pL sample loop (P/N 042857) is installed on the valve at the factory.
See Section 2.4.4 for details about valve operation.

Auxiliary Valve (Optional)

The auxiliary valve is a two-position, electrically-activated Rheodyne
valve (6-Port Valve Kit, P/N 069472; 10-Port Valve Kit, P/N 069473).
See Section 2.4.4 for details about valve operation.

DS6 Heated Conductivity Cell

The flow-through conductivity cell measures the electrical conductance
of analyte ions as they pass through the cell. A heat exchanger inside the
cell regulates the temperature, which can be set to between 30 and 55 °C.
For optimum performance, set the temperature to at least 7 °C above the
ambient temperature and 5 °C above the column oven temperature. See
Section 2.4.8 for details about the cell.

Doc. 065289-03 10/12 15
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Suppressor

The suppressor reduces the eluent conductivity and enhances the
conductivity of the sample ions, thereby increasing detection sensitivity.

Either a Dionex AES" Atlas Electrolytic Suppressor, Dionex SRS Self-

Regenerating Suppressor, or Dionex MMS™ MicroMembrane™
Suppressor can be used with the Dionex 1CS-1100. See Section 2.4.7 for
details about the suppressor.

Separator and Guard Columns

Both the separator and guard columns are packed with resin and perform
the separation of the sample ions. The main function of the guard column
is to trap contaminants and remove particulates that might damage the
separator column.

Column Heater (Optional)

The column heater controls the temperature of the separator and guard
columns. The temperature can be set to between 30 and 60 °C; however,
it must be set to at least 5 °C above the ambient temperature. See
Section 2.4.6 for details about the column heater.

Eluent Valve

The eluent valve controls the flow from the eluent reservoir. The eluent
valve opens automatically when the pump is started and closes when the
pump is turned off.

Tubing Chases

The upper tubing chase routes tubing from the top cover to the component
panel. The lower tubing chase routes tubing from the component panel,
through the interior of the Dionex 1CS-1100, to the rear panel. It also
routes tubing from the RFIC-ER compartment, through the interior of the
Dionex 1CS-1100, to the component panel.

16 Doc. 065289-03 10/12
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2.1.4 Right-Side Panel

Figure 2-5 illustrates the RFIC-ER compartment on the right side of the
Dionex 1CS-1100.

Figure 2-5. RFIC-ER Compartment (Cover Removed)

The compartment houses the ER Controller (ERC 10) and various
columns required for operation in the RFIC-ER mode. The ERC 10
electronics monitor the volume of electrolysis gases (such as hydrogen
and oxygen) in the eluent stream. If the predefined safety limit is
exceeded, the ERC 10 shuts down the pump to prevent the buildup of
gases in the eluent bottle.

If you plan to operate in the RFIC-ER mode, you must order one of these
Kits:

e RFIC-ER Anion Startup Kit, ICS-1100/1CS-1600 (P/N 069570)
e RFIC-ER Cation Startup Kit, 1CS-1100/ICS-1600 (P/N 069569)

Each Startup Kit includes one Installation Kit and one Consumables Kit.
Together, these kits contain additional items (purification columns, a

Doc. 065289-03 10/12 17
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special eluent bottle, etc.) required for RFIC-ER operation. For more
information, refer to the manual shipped with the Installation Kit.

2.1.5 Rear Panel
Figure 2-6 illustrates the Dionex ICS-1100 rear panel.

Tubing Clips

Power Switch

Upper Chase

Analog Output

/_ Connector

|

USB

Waste Lines (3) - '
\ Tomr / Connectors

TTL and Relay

l/ Connector Strip

Main Power
Receptacle

Lower Chase

Figure 2-6. Dionex ICS-1100 Rear Panel

Analog Output Connector

The analog output connector outputs conductivity data (asa0Oto 1V
signal) to an integrator or recording device. For connection and setup
information, refer to the Dionex ICS-1100 installation instructions.

18

Doc. 065289-03 10/12




2 « Features

USB Connectors

A USB receptacle is provided to allow connection to the Chromeleon
computer. Two USB ports are provided for connecting to other USB
devices. For connection instructions, refer to the Dionex ICS-1100
installation instructions.

TTL and Relay Connector

The TTL and Relay connector strip provides two TTL outputs, two relay
outputs, and four TTL inputs. The outputs can be used to control
functions in other TTL- or relay-controllable devices. The inputs can be
used to switch the injection valve position, turn on the pump, perform an
autozero command, and send an event mark to the analog output. See
Section B.1 for connection instructions.

Tubing Chases

The upper tubing chase routes tubing from the RFIC-ER compartment to
the Dionex 1CS-1100 rear panel. The lower chase routes tubing from the
rear panel to the component panel.

Tubing Clips
The tubing clips hold tubing routed from the top cover in place.

Power Switch

The power switch provides on/off control of power to the Dionex ICS-
1100.

Main Power Receptacle

The power supply cord plugs into the AC power receptacle.

The power supply cord is used as the main disconnect device. Make
sure the socket-outlet is located near the Dionex ICS-1100 and is

easily accessible.
CAUTION _ _ o . ) -
Le cordon d'alimentation principal est utilisé comme dispositif

principal de débranchement. Veillez a ce que la prise de base soit

situéelinstallée prés du module et facilement accessible.
MISE EN GARDE . . ) .
Das Netzkabel ist das wichtigste Mittel zur Stromunterbrechung.

Stellen Sie sicher, daB sich die Steckdose nahe am Gerat befindet und
leicht zuganglich ist.
VORSICHT
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2.2

Flow Schematics

The following figures illustrate the liquid flow path through a Dionex 1CS-1100
when using suppression in autorecycle mode. Two configurations are shown:

Figure 2-7 illustrates the liquid flow path through components when
performing conventional ion chromatography.

Figure 2-8 illustrates the liquid flow path through components when operating
in the RFIC-ER mode.

Flow Description for Standard Configuration

Eluent from the eluent reservoir @ flows first through the pump degas
assembly (if it is installed) and then through the eluent valve ®to the pump®.
The eluent is then pushed through the pressure transducer@, which measures
the system pressure.

From there, the eluent is pushed through a pulse damper®, which smooths
minor pressure variations from the pump to minimize baseline noise. The
eluent then flows into the injection valve ®.

After sample is loaded into the sample loop @ and the injection valve is
toggled to the Inject position, eluent passes through the sample loop.

If the optional column heater is installed, the eluent/sample mixture is
pumped through the heat exchanger @, which heats the mixture to the column
heater temperature.

The mixture then goes to the guard and separator columns © and through the
suppressor @.

From the suppressor, the mixture flows through the cell ®, where the analytes
are detected. A digital signal is sent to Chromeleon software. Analog output
can be collected simultaneously.

Finally, the mixture flows out of the cell and is recycled back into the
suppressor, where it is used as the water source for the regenerant chamber.
Flow is then routed to waste ®.

20
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Figure 2-7. Dionex ICS-1100 Flow Schematic: Standard Configuration

Doc. 065289-03 10/12

21



Dionex ICS-1100 lon Chromatography System

Flow Description for RFIC-ER Mode

Eluent from the eluent reservoir @ flows first through the pump degas
assembly (if it is installed) and then through the eluent valve®to the pump®.
The eluent is then pushed through the pressure transducer@, which measures
the system pressure.

From there, the eluent is pushed through a pulse damper®, which smooths
minor pressure variations from the pump to minimize baseline noise. The
eluent then flows through the ER1 column ® and into the injection valve @.

After sample is loaded into the sample loop © and the injection valve is
toggled to the Inject position, eluent passes through the sample loop.

If the optional column heater is installed, the eluent/sample mixture is
pumped through the heat exchanger ©, which heats the mixture to the column
heater temperature.

The mixture then goes to the guard and separator columns ® and through the
suppressor ®.

From the suppressor, the mixture flows through the cell @, where the analytes
are detected. A digital signal is sent to Chromeleon software. Analog output
can be collected simultaneously.

Finally, the mixture flows out of the cell, through the ER2 column®, and is
then recycled back into the suppressor.

From the suppressor, flow moves to the ER3a and ER3b@ columns, which
remove contaminants from the eluent.

The ERC 10@ monitors the eluent for gas and shuts down the pump if the gas
exceeds a pre-defined limit.

Finally, the output from the ERC 10 is recycled back to the eluent bottle.

22
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Figure 2-8. Dionex ICS-1100 Flow Schematic: RFIC-ER Mode
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2.3 Chromeleon and Chromeleon Xpress
The Dionex ICS-1100 is controlled by a PC configured with Chromeleon
Chromatography Management System or Chromeleon Xpress. Chromeleon
Chromatography Management System provides complete instrument control, data
acquisition, and data management. Chromeleon Xpress provides real-time control
and monitoring of instruments, but does not include data management
capabilities.
2.3.1 The Panel Tabset
The Chromeleon and Chromeleon Xpress panel tabset provides a
centralized location for controlling system functions. A panel tabset for a
Dionex 1CS-1100 system typically includes the following Control panels:
* A Dionex ICS-1100 Control panel (see Figure 2-9) provides access to
Dionex ICS-1100 functions. The label on the tab for this panel is the
name of the timebase in which the Dionex 1CS-1100 is configured.
1CS-1100_Timebase =3
ICS-1100 Spstem -1CS-1100_Timebase - CMADLER1 ‘HF\E-EH -We\\nass} Sequence Euﬂlru\l Stalusl Aulusamp\ell
Pumy Sampl System Log [Audit Trail] on ICS-1100_Timehase——
ump - Off- Datasource: |:| @5:46:54 AM {Pump_ECD) The ERC 10 is linked to the &
ﬁj Sequence: [ ] (D3:45 54 AM {Pump_ECD} Please verffy the sobvent and
Pump Settings... Psrogrla:n: : @465 AlM_ManuaHy acquired samples will be stored
Inject Elapsed Program Time: 1CS-1100 Syst
H Total Program Time: : l ¥ Connected  Startup | Shul(lown‘ ShowPIotH
H Load |t | # 5000 il from Pos. 1
Suppressor - Off-
0
: Detector Settings...
Figure 2-9. Dionex ICS-1100 Control Panel on the Panel Tabset
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= A Sequence Control panel lets you define and run sequences (groups
of sample injections to be analyzed in the order in which they are
listed).

* A Status panel shows the overall system status.

* An Autosampler panel (included if the Dionex ICS-1100 is
connected to a Dionex AS, Dionex AS-AP, Dionex AS-DV, or
Dionex AS-HV Autosampler) provides access to autosampler
functions.

To open the panel tabset, use one of the methods below:

e |f Chromeleon is installed,
start Chromeleon and click
the Default Panel Tabset
toolbar button, or select

View > Default Panel
Tabset. e

“* Chromeleon

File View ‘Workspace Tools Help

e If Chromeleon Xpress is
installed, start the application; this automatically displays the Dionex
ICS-1100 panel tabset.

2.3.2 Software Control Modes

Two modes of software control are available: direct control and
programmed control.

= With direct control, you select operating parameters and commands
from the Control panels. Direct control commands are executed as
soon as they are entered.

= With programmed control, you create a list of control commands to
be executed in chronological order. Programs can be created
automatically (with the help of a software wizard).

2.3.3 System Wellness

System Wellness monitors the overall “health” of a chromatographic
system. It provides built-in diagnostic and calibration features that help
prevent unscheduled system shutdowns and assure reliable operation of
system devices. For details about System Wellness, see Section 5.1.
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2.4 System Component Details

This section provides details about Dionex 1CS-1100 system components,
including the vacuum degas assembly (optional), RFIC-ER components, eluent
valve, pump, injection valve, column heater (optional), suppressor, and
conductivity cell.

2.4.1 Vacuum Degas Assembly (Optional)

The vacuum degas assembly provides online eluent degassing at the time
and duration specified by the user. The assembly, which must be installed
in the Dionex ICS-1100 at the factory, consists of:

A single-channel degas chamber (with degas membranes) with
internal capacity of 17 mL

A dual-stage diaphragm vacuum pump

A solenoid valve

An on-board vacuum sensor

The electronics required to operate the vacuum pump

Tubing, fittings, and other accessories

By default, the Dionex ICS-1100 monitors the degas pressure reading and
turns the degas pump on and off as needed. Different degas operating
modes can be selected from Chromeleon.

To select the degas operating options, open the Chromeleon Server
Configuration program, right-click the Dionex 1CS-1100 device in the
timebase, and select Properties.

26
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Select the Options tab (see Figure 2-10).

Dionex ICS-1100 IC System X
Solvents ] State Devices ] Inject Valve ] Error Levels ] Demo Chromatogram ]
TTL Inputs ] Trend ] Calibration ] Diaghostic: ]
General Optione Signalz ] Head Type & Limitz I
I+ Degas
0 Always Off
" Always On
" Cycle On: [0.1205ec)  Off [0..5940 sec)
(% Maritor

¥ Calumn Heater

[~ Walve 2
RFICER
Link to ERC Contraller: <Moner j
0K | Cancel | | Help |

Figure 2-10. Server Configuration Properties: Degas Options

Degas Options

* Always Off: The degas pump is always off.

Always On: The degas pump is always on. This setting is for test

purposes by a Thermo Fisher Scientific Service Representative. Do

not use this setting for routine operation.

Cycle: The degas pump cycles on and off according to the times

specified in the Cycle On and Off fields. Cycle On specifies for how
long the degas pump runs during a cycle. Cycle Off specifies the time

between cycles.

Monitor: (default mode) The Dionex 1CS-1100 monitors the degas

pressure reading and turns the degas pump on and off as required.

Doc. 065289-03 10/12
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24.2

Eluent Valve

B ‘.ﬁa IN
- s - r

The eluent valve controls the flow from
the eluent reservoir. The valve opens
automatically when the pump is started
and closes when the pump is turned off.
The valve can also be opened and closed
manually from the Chromeleon Control
panel (see Section 2.3.1). This lets you
perform service procedures on pump
components without eluent leaks
occurring.

Figure 2-11. Eluent Valve

2.4.3

Pump

The Dionex ICS-1100 pump is a microprocessor-based isocratic eluent
delivery system. Its variable speed, dual-piston series design ensures
pulse-free pumping for the most demanding applications.

Primary Pump Head

The primary pump head pumps eluent into the secondary head (see
Figure 2-12). The check valves, which prevent reverse flow through the
pump, are located on the bottom (inlet) and top (outlet) of the primary
pump head. The priming valve is on the front of the pump head.

To open the priming valve, turn the knob one-quarter to one-half turn
counterclockwise. When the priming valve is open, liquid can flow into
and out of the primary pump head via the port in the front of the valve.

NOTE The priming valve must be open when the pump is
being primed with a syringe or with isopropyl
alcohol. For detailed priming instructions, see
Section 5.16.

28
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Outlet Check

Valve
Secondary Bri
Pump Head rimary
Pump Head
Waste Valve Priming
"~ Valve
¥/
Inlet Check
Valve
Pressure
Transducer

Figure 2-12. Dionex ICS-1100 Pump Components

Secondary Pump Head

The secondary pump head delivers eluent to the remainder of the
chromatography system (the injection valve, column, and detector). The
waste valve is located on the front of the secondary pump head (see

Figure 2-12).

To open the waste valve, turn the knob one-quarter to one-half turn
counterclockwise. When the waste valve is in the open position, all pump
flow is directed to waste.

NOTE The waste valve must be open when the pump is
being primed using the Prime button. For detailed
priming instructions, see Section 5.16.
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24.4

Pressure Transducer

Flow exiting the secondary pump head is directed to the pressure
transducer (see Figure 2-12), which measures the system pressure.

Pressure readings indicate that the pumping system is delivering smooth,
accurate flow. Pressure readings can be monitored from the Chromeleon
Control panel.

The system pressure should remain consistent (no more than a 3%
difference from one pressure reading to the next). High and low pressure
limits can be used to stop the pump flow if a limit is exceeded. The
pressure limits can be set from Chromeleon (in the Server Configuration
or in the control program). See Section 4.2 for troubleshooting
information if a pressure limit is exceeded.

Pulse Damper

Flow output from the pressure transducer continues to the pulse damper,
which smooths minor pressure variations. From there, flow is directed to
the injection valve and then to the remainder of the chromatography
system.

Piston Seal Wash

The pump includes a piston seal wash assembly that can be set up to
continuously rinse the back of the piston seals to remove salt crystals and
prolong the life of the seals. To use this feature, an external water source
must be connected. For connection instructions, refer to the Dionex ICS-
1100 installation instructions.

For continued protection of the pump, replace the piston rinse seals (see
Section 5.7) and O-rings in the seal wash assembly every 6 months, or
whenever you replace the main piston seals for the Dionex ICS-1100

pump.

Injection Valve

The injection valve (P/N 057968) is a six-port, electrically-activated
valve. A 25-uL sample loop (P/N 042857) is installed on the valve at the
factory.

The valve has two operating positions: Load and Inject (see Figure 2-13).
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LOAD POSITION INJECT POSITION

Samplelnw Sample InW

To Column

To Column

......

......

To Waste From Pump To Waste From Pump

Figure 2-13. Injection Valve Flow Schematics

Eluent flows through either the Load or Inject path, depending on the
valve position.

* Inthe Load position, sample is loaded into the sample loop, where it
is held until injection. Eluent flows from the pump, through the valve,
and to the column, bypassing the sample loop. Sample flows from the
syringe or automated sampler line (if installed), through the valve,
and into the sample loop. Excess sample flows out to waste.

* Inthe Inject position, sample is swept to the column for analysis.
Eluent flows from the pump, through the sample loop, and on to the
column, carrying the contents of the sample loop with it. Section 3.10
describes how to inject samples.

Figure 2-14 shows the injection valve connections. The injection valve is
plumbed at the factory with all tubing and fittings for connection to the

pump, injection port, column, and waste. A 25-uL PEEK™ sample loop
(P/N 042857) is installed between ports L (1) and L (4). Thermo Fisher
Scientific offers sample loops in various sizes. If necessary, the pre-
installed 25-uL loop can be replaced with a loop that has a different
sample injection volume.
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SAMPLE IN
(from door X\A
inject port or
autosampler) O .
25-uL
SAMPLE LOOP
TO INJ
(Orange) VALVE -c (Black)
N
TO INJECT | (Green)
TO VALVE -P
VALVE -W .

I (Green)
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Figure 2-14. Injection Valve Plumbing

Auxiliary Valve (Optional)

The auxiliary valve is a high-pressure Rheodyne valve. The electrically-
activated, 2-position PEEK valve is offered in both 6-port and 10-port
models (6-Port Valve Kit, P/N 069472; 10-Port Valve Kit, P/N 069473).
The auxiliary valve enables a variety of sample preparation activities,
including:

Online filtration

Matrix elimination (for example, the removal of high backgrounds of
chloride or organic material)

Concentrator-based techniques

Conditional injections (large loop/small loop applications where the
data system monitors sample concentration and reinjects the sample,
using the smaller loop, if the concentration is too high)

AutoNeutralization™

Matrix diversion prior to MS (mass spectrometry) detection

For more information, refer to Installing the 1CS-1100/1CS-1600/ICS-
2100 Auxiliary Valve (Document No. 065288). The manual is provided in
the Auxiliary Valve Kit.
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2.4.6 Column Heater (Optional)

The column heater provides temperature
control for the separator and guard column.

The heater temperature can be set to between
30 °C and 60 °C. However, the set
temperature must be at least 5 °C above the
ambient temperature. A thermistor mounted
in the heater block monitors the temperature.
Setting the temperature to 0 °C turns off the
column heater.

If the temperature exceeds 65 °C, the
column heater is shut off and the error
message “Column heater exceeds safe
temperature.” is displayed in the
Chromeleon Audit Trail. See Section 4.2 for
troubleshooting information.

The column heater can either be installed at
the factory or ordered separately

(P/N 069564) and installed on-site.

For best results with 2-mm columns, a
microbore heat exchanger (P/N 060943)
should be installed in the column heater (see
Section 5.13). The tubing connections
between the injection valve and column heat
exchanger, guard column and separator
column, and separator column to detector
cell should all use red 0.125-mm, 0.005-in
ID PEEK tubing (P/N 044221), rather than
the standard black tubing.

Figure 2-15. Column Heater
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247

2.4.8

Suppressor

The suppressor reduces the eluent conductivity and enhances the
conductivity of the sample ions, thereby increasing detection sensitivity.
Either a Dionex Atlas Electrolytic Suppressor, Dionex Self-Regenerating
Suppressor, or Dionex MicroMembrane Suppressor can be used with the
Dionex ICS-1100.

For details about any of the suppressors or for information about selecting
a suppressor for your application, refer to the suppressor manuals. The
manuals are on the Thermo Scientific Reference Library DVD

(P/N 053891).

DS6 Heated Conductivity Cell

The flow-through conductivity cell measures the electrical conductance
of analyte ions as they pass through the cell. Two passivated 316 stainless
steel electrodes are permanently sealed into the PEEK cell body. The cell
design provides efficient sweep-out, low volume (1 uL), and low
dispersion. Temperature control and compensation help ensure good peak
reproducibility and baseline stability.

Temperature Control

Temperature directly affects the conductivity of a solution. For example,
laboratory heating and air conditioning systems can cause a regular slow
cycling in the baseline. This, in turn, can affect the reproducibility of an

analysis. The higher the conductivity, the more pronounced the effect.

In ion analysis, the effect of temperature variation is minimized by
suppressing eluent conductivity. To further reduce the effect of
temperature variation, a heater inside the cell regulates the temperature.
The cell heater can be set to between 30 °C and 55 °C. The set
temperature must be at least 7 °C above the ambient temperature. Setting
the cell temperature to 0 °C turns off the cell heater.

Temperature Compensation

Built-in preset temperature compensation of 1.7% per °C helps minimize
changes in the baseline or in peak heights when the operating temperature
is different from the temperature at which the cell was calibrated.

34
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DS6 Heated Conductivity Cell Components

The cell front cover provides CELL IN and CELL OuUT fittings for
connecting the cell to the suppressor (see Figure 2-4). The remaining cell
components are mounted behind the component panel. To replace, the cell
remove the screws on the cell front cover and pull the entire cell assembly
out through the component panel. See Section 5.10 for cell replacement
instructions.

ER Controller

The ER Controller (ERC 10) is installed in the RFIC-ER compartment at
the factory. During operation in the RFIC-ER mode, the ERC 10
electronics monitor the volume of electrolysis gases (such as hydrogen
and oxygen) in the eluent stream. If the predefined safety limit is
exceeded, the ERC 10 shuts down the Dionex ICS-1100 pump to prevent
the buildup of gases in the eluent bottle.
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3.1

This chapter describes routine operating and maintenance procedures for the
Dionex I1CS-1100.

The Dionex ICS-1100 is designed for IC (ion chromatography) applications and
should not be used for any other purpose. Operation of the Dionex ICS-1100 in a
manner not specified by Thermo Fisher Scientific may result in personal injury.

Operation Overview

Figure 3-1 illustrates the basic steps for routine operation of the Dionex 1CS-1100.

Power up the system

C Start Chromeleon )

¥

Set up the reservoir
(or RFIC-ER system)
Check all
connections

C Prime the pump

% )

Set operating
conditions

Equilibrate the
system

Prepare samples

Verify operating
status

Process samples

Figure 3-1. Operation Flow Chart
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Sample Processing Overview

Samples can be run manually (one at a time), or they can be grouped and run
automatically in batches. Figure 3-2 shows the typical steps for manual and batch
sample processing.

Manual Sample Batch Sample
Processing Processing
Using Chromeleon Using Chromeleon

Sequence Wizard

Start data ‘
acquisition [Add the Sequence]

CLoad the samp|e> E:reate a Sequence
. | ’

to the Batch

( Autozero > ‘
C Start the Batch >

(Inject the sample>

Stop data
acquisition

(Optional)
Save the manual
sequence data

Figure 3-2. Sample Processing Overview
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3.2 Turning On the System Power

Press the power switch on the
Dionex ICS-1100 rear panel (see
Power Figure 3-3) to turn on the system
Switch power. Table 3-2 shows the Dionex
ICS-1100 conditions at power-up.
Also turn on the power to the
computer and the autosampler (if
used).
Figure 3-3. Dionex ICS-1100 Rear Panel
Feature Power-Up Condition
Pump Off
Injection valve Load position
Cell Reading current value
Suppressor Off*
Cell heater Set to the last value used. The default when the Dionex
ICS-1100 is turned on for the first time is 35 °C.
Column oven temperature Set to the last value used. The default when the Dionex
(Optional) ICS-1100 is turned on for the first time is 30 °C.
* When you start the suppressor, the value used last is restored.

Table 3-2. Dionex ICS-1100 Power-Up Conditions
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3.3 Connecting to Chromeleon

NOTE If you are beginning operation of a Dionex ICS-1100
that has not been configured in a timebase, refer to the
Dionex ICS-1100 installation instructions for
Chromeleon setup instructions.

1. Turn onthe PC.
2. Start the Chromeleon Server, if it is not already running.
a. Check the Chromeleon Server Monitor icon on the Windows taskbar.
e When the server is running, the icon is gray %

e When the Server is not running, the icon is crossed out in red ﬁ ).
To start the server, right-click the icon and select Start Server.

b. If the Server Monitor icon is not on the Windows taskbar, click Start >
All Programs > Chromeleon > Server Monitor. The Server Monitor
opens. Click Start to start the server.

3. To start the Chromeleon client, click Start and select All Programs >
Chromeleon > Chromeleon.

4. If Chromeleon is installed, the main
window and Browser appeatr.
Display the panel tabset by
selecting View > Default Panel

Tabset or by clicking the Default
Panel Tabset toolbar button. - ,_._._

“* Chromeleon

File Wiew ‘Workspace Tools Help

If Chromeleon Xpress is installed,
starting the application automatically displays the panel tabset.

5. To display the Dionex ICS-1100 Control panel, click the tab labeled with the
Dionex 1CS-1100 timebase name (see Figure 3-4).
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IC5-1100_Timebase & #¢
IC5-1100 Spstem - 1C5-1100_Timebase - CMADLERT | RFICER - Wellness | Sequence Control | Status | Autasampler |
Pump: Sampl. System Log [Audit Trail] on ICS-1100_Timebhase =

Datasource: l:l [@9:45:54 AM {Pump_ECD} The ERC 10 is linked 1o the  #
rmodule
FD Sequence: | (T19:46:54 A {Pump_ECD} Please werify the solvent and
T — AR

Pump Settings... 3:45:55 AN Manually acquired samples will be stored

Progam: | | temporarily in sequence

Inject Elapsed Program Time: 1CS-1100 Syst
E LoadPosition Total Program Time: l:l l [v Connected  Startup | Shutdown| Show Plot”

# 5000 pl from Pos. 1
Load Inject

Injector Settings...

Suppressor - Oﬁ]

Detector Settings...

T T
0.00 0.50 1.00 1.50 2.00 2.50 3.00

Figure 3-4. Dionex ICS-1100 Control Panel on the Chromeleon Panel Tabset

Doc. 065289-03 10/12 41



Dionex ICS-1100 lon Chromatography System

3.4 Set Up the Eluent Reservoir

3.4.1

3.4.2

NOTE If you plan to operate the system in the RFIC-ER mode,

disregard the instructions here. Follow the instructions
provided with your RFIC-ER Installation Kit to set up
the RFIC-ER eluent reservoir.

Prepare the Eluent

Prepare the eluent according to the instructions in the column manual.
Column manuals are included on the Dionex Reference Library CD-ROM
(P/N 053891).

Degas the Eluent

Eluent quality significantly affects the performance of the Dionex ICS-
1100. To ensure optimal pump performance, observe the following
precautions:

Dionex strongly recommends vacuum degassing all eluents. This
helps prevent bubbles, caused by outgassing, from forming in the
pump heads and the detector flow cell.

The optional vacuum degas assembly provides programmable, online
degassing. The degas assembly must be installed in the Dionex ICS-
1100 at the factory. If the Dionex ICS-1100 does not contain a degas
assembly, manually degas eluent daily (following the instructions
below) and store it in pressurized reservoirs.

Manual Degassing of Eluent

1.

Prepare the eluent required for the application and pour it into a
vacuum flask.

Attach the flask to a vacuum pump or water aspirator.
Vacuum degas the eluent for 5 to 10 minutes by shaking or sonication.

Remove the flask from the vacuum. Do not allow eluent to flow
from the aspirator back into the flask.

Pour the degassed eluent into a pressurizable reservoir. Do not shake
the eluent.

42
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6. Install an end-line filter on the eluent line (see Section 3.4.3).
7. (Optional) Pressurize the reservoir.

The Dionex ICS-1100 does not require pressurized reservoirs.
However, if eluent is manually degassed or is sensitive to
contamination, Dionex recommends pressurizing the reservoir with
helium or nitrogen.

The air regulator accessory bracket and other items needed for
pressurizing the eluent reservoir must be ordered separately

(P/N 060054). For more information, refer to the Dionex ICS-1100
installation instructions.

3.4.3 Filter the Eluent

Filtering removes small particulates in the eluent that may contaminate
the pump check valves and cause erratic flow rates or loss of prime. An
end-line filter (P/N 045987) is provided in the Dionex ICS-1100 Ship Kit
(P/N 057905) for this purpose.

Install the end-line filter on the end of the eluent line, inside the reservoir.
Verify that the end of the filter extends to the bottom of the reservoir and
that the filter is submerged in eluent. This prevents air from being drawn
through the lines.

3.4.4 Fill the Reservoir
Fill the reservoir with the prepared eluent.

3.45 Set the Eluent Level

After filling the reservoir, enter the volume of liquid in the reservoir on
the Dionex 1CS-1100 Control panel on the Chromeleon panel tabset (see
Figure 3-5).

The Dionex ICS-1100 determines the eluent usage by monitoring the flow
rate and the length of time the pump is on, and updates the Eluent Bottle
volume as the eluent is depleted. A warning appears if the level falls
below 200 mL. Warnings are repeated at 100 mL and 0 mL.
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In order for the level displayed in the Eluent bottle box and gauge to

@-} be accurate, you must enter the level when the reservoir is filled. The
Dionex ICS-1100 does not automatically detect when the reservoir is
filled, nor when it is empty.

ICS-1100 Pump Settings - ICS-1100_Timebase - (M...

‘Pump Settings—

Enter the _ 1.00 ml/min -

volume of

Lo ‘Eluent Bottle - Off | On | Prime [|

liquid inthe —_§ | | - |

reservoir (in ej2001 =

liters) = Eluent Flow Valve ————

i Closed | Open ]
= ——
- Max. Pressure: = 5000 psi |
23 : .
£ Curr. Pressure: | 800 psi |
-1 Min. Pressure: 0 psi J Note: The Eluent
& —_— Bottle field and slider

0 o | gauge are updated as
IEEIRRREER— 2001 ‘__ the liquid is depleted.

Close |

Figure 3-5. Pump Settings Window: Setting the Eluent Level

3.4.6 Connect the Reservoir

If it is not already connected, connect the ELUENT BOTTLE OUT line from
the reservoir cap to the ELUENT IN line, which extends from the plumbing
and cable chase on the top of the Dionex 1CS-1100.

3.5 Check All Connections

Make sure the eluent reservoir is filled and the tubing connecting the reservoir to
the Dionex ICS-1100 tubing is securely connected.
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3.6 Prime the Pump

If you changed eluent or if the eluent lines are dry, prime the lines first

with a syringe before following the procedure below to prime the
pump. See Section 5.16.1 for instructions on priming the lines with a

syringe.

1. Verify that the priming valve on the primary pump head (see Figure 3-6) is
closed (turned all the way clockwise).

2. Open the waste valve on the secondary pump head by turning the knob one-
quarter to one-half turn counterclockwise. Opening the valve directs the
eluent flow path to waste and eliminates backpressure.

Secondary
Pump Head

Waste Valve
(open)

Primary
Pump Head

Priming Valve
(close)

Figure 3-6. Priming the Pump

3. Press Prime on the Chromeleon Control panel. The pump will begin pumping
at approximately 3 mL/min.

4. Continue priming the Dionex ICS-1100 until all air and previous eluent are
purged and no air bubbles are exiting the waste line.

5. Press Pump Off.

6. Close the waste valve. Do not overtighten. The pump is now ready for
operation.
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3.7

3.8

Set System Operating Conditions

NOTE This section is an overview of the steps needed to start
up the system and begin running samples. Actual
operating parameters (flow rate, cell heater
temperature, suppressor current, etc.) depend on the
application to be run. Refer to the column manual for
the required parameters for your application.

Set or verify system operating parameters from the Chromeleon Control panel.
Operating parameters can also be set automatically by loading a Chromeleon
sequence.

NOTE Clicking the System Startup button on the Chromeleon
Control panel starts the pump and suppressor. The flow
rate and suppressor current settings that were in effect
when the system was shut down are restored.

Verify that the pump is on and set to the correct flow rate.
Verify that the suppressor current is on and that the setting is correct.

Verify that the cell heater is set to the correct value.

Eal A

Verify that the column heater is set to the correct value.

Equilibrate the System and Verify Operational Status

1. Allow the system to equilibrate. During equilibration, the Chromeleon
Control panel displays the background conductivity (the conductivity of the
eluent before sample injection) and the system backpressure.

2. Monitor the background conductivity. Refer to the column manual for the
appropriate background conductivity for your application.

3. Offset the background and zero the reading by clicking the Autozero button
on the Chromeleon Control panel (see Figure 3-4).

4. Monitor the system pressure from the Control panel to make sure it is at the
expected pressure for the installed column (refer to the column manual for
details) and is stable.
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= If the pressure is less than the expected amount, gas may be trapped in the
system. To release the gas, remove the pump fitting on the injection valve
port, labeled P (2). Allow the air to escape and then reconnect the fitting.

e If the pressure fluctuates by more than about 0.13 MPa (20 psi), prime the
pump. See Section 4.4 for additional troubleshooting information.

e |f the pressure is too high, there may be a restriction in the system
plumbing. See Section 4.8 for troubleshooting information.

5. Verify that the baseline conductivity is at the expected reading for your
application and is stable. In general, it should be <30 uS for a system set up
for anion analyses and <2 uS for a system set up for cation analyses. See
Section 4.13 for troubleshooting information if the conductivity is too high.
See Section 4.14 if the baseline is drifting or has excessive “noise” (large
fluctuations in readings).

6. Verify that the cell heater is at the set point and is stable. The temperature is at
equilibrium when the Set Temperature and Current Temperature readings
on the Control panel are the same.

7. Verify that the column heater temperature (if installed) is at the set point and
stable. The temperature is at equilibrium when the Set Temperature and
Current Temperature readings on the Control panel are the same.

The system is now ready for sample processing.

3.9 Prepare Samples

NOTE Sample preparation can be performed while the system
is equilibrating.

3.9.1 Collecting and Storing Samples

Collect samples in high density polyethylene containers that have been
thoroughly cleaned with deionized (DI) water. Do not clean containers
with strong acids or detergents because these can leave traces of ions on
the container walls. The ions may interfere with the analysis.

If samples will not be analyzed on the day they are collected, filter them
through clean 0.45 um filters immediately after collection; otherwise,
bacteria in the samples may cause the ionic concentrations to change over
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3.9.2

3.9.3

time. Refrigerating the samples at 4° C (39° F) will reduce, but not
eliminate, bacterial growth.

Analyze samples containing nitrite or sulfite as soon as possible. Nitrite
oxidizes to nitrate, and sulfite to sulfate, thus increasing the measured
concentrations of these ions in the sample. In general, samples that do not
contain nitrite or sulfite can be refrigerated for at least one week with no
significant changes in anion concentrations.

Pretreating Samples

Analyze rainwater, drinking water, and air particulate leach solutions
directly with no sample preparation (other than filtering and possibly
diluting).

Filter groundwater and wastewater samples through 0.45 pum filters
before injection, unless samples were filtered after collection.

Before injection, pretreat samples that may contain high concentrations of

interfering substances by putting them through Dionex OnGuard™
cartridges. Refer to Installation and Troubleshooting Guide for OnGuard
Cartridges (Document No. 032943) for instructions.

Diluting Samples

Because the concentrations of ionic species in different samples can vary
widely from sample to sample, no single dilution factor can be
recommended for all samples of one type. In some cases (for example,
many water samples), concentrations are so low that dilution is not
necessary.

Use eluent or ASTM filtered, Type | (18-megohm) deionized water to
dilute the sample. When using carbonate eluents, diluting with eluent
minimizes the effect of the water dip at the beginning of the
chromatogram. If you dilute the sample with eluent, also use eluent from
the same lot to prepare the calibration standards. This is most important
for fluoride and chloride, which elute near the water dip.

To improve the accuracy of early eluting peak determinations, such as
fluoride, at concentrations below 50 ppb, dilute standards in eluent or
spike the samples with concentrated eluent to minimize the water dip. For
example, spike a 100 mL sample with 1.0 mL of a 100 X eluent
concentrate.
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3.10 Loading and Injecting Samples

NOTE Samples can be injected using either the standard
injection valve or the optional auxiliary valve, if
installed. For more information, see the Chromeleon
Help or user’s manual.

The two techniques for loading samples into the sample loop are: (1) with an
autosampler or (2) with a syringe or vacuum syringe through the injection port on
the Dionex I1CS-1100 front door.

For autosampler injections, the injection port tubing is disconnected from the
Dionex ICS-1100 injection valve and replaced by the autosampler outlet tubing.
Other setup requirements depend upon the model of autosampler.

Setup for a Dionex AS Autosampler
To use a Dionex AS Autosampler with the Dionex 1CS-1100, the following
requirements must be met:

e The Dionex ICS-1100 injection valve (or the auxiliary valve, if installed) must
be specified as the injection valve and must be linked to the Dionex AS in the
Chromeleon timebase.

* Aninjection valve should not be installed in the AS.

See the Dionex ICS-1100 installation instructions for Dionex AS connection
instructions.

Setup for a Dionex AS-DV Autosampler
To use a Dionex AS-DV Autosampler with the Dionex I1CS-1100, the following
requirements must be met:

e The Dionex ICS-1100 injection valve must be linked to the Dionex AS-DV in
the Chromeleon timebase.

Setup for a Dionex AS-HV Autosampler

For setup information for the AS-HV Autosampler, see the AS-HV Autosampler
Operator’s Manual (Document No. 065125). The manual is provided on the
Thermo Scientific Reference Library DVD (P/N 053891).
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3.10.1 Loading Samples with a Syringe

1. Make sure the injection port on the Dionex ICS-1100 front door (see
Figure 2-1) is connected to sample port s (5) on the injection valve

(see Figure 3-7).

SAMPLE IN

(from door N\
inject port or - *x
autosampler) F

25-uL
SAMPLE LOOP TO INJ
(Orange) VALVE -C ™ (Black)

TO INJ T&&JEEgT k= (Green)
VALVE -W
I (Green)

Figure 3-7. Injection Valve Connections
2. Fill the 1 cc syringe (P/N 016388) provided in the Dionex 1CS-1100
Ship Kit (P/N 057905) with a calibration standard or sample.

3. Insert the syringe into the injection port on the Dionex 1CS-1100 front
door (see Figure 2-1).

4. Verify that the injection valve is in the Load position.

5. Overfill the sample loop with several sample loop volumes. Excess
sample will exit through the injection valve waste line.

6. Leave the syringe in the port.
7. Switch the injection valve to the Inject position (see Section 3.10.4).
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3.10.2 Loading Samples with a Vacuum Syringe

1. Disconnect the waste line from port w (6) of the injection valve (see
Figure 3-7) and attach a shorter line: 25 to 30 cm (10 to 12 inches) of
PEEK or PTFE (polytetrafluoroethylene) tubing.

2. Place the free end of the line into the sample.
3. Verify that the injection valve is in the Load position.

4. Insert the 1 cc syringe (P/N 016388) provided in the Dionex ICS-
1100 Ship Kit (P/N 057905) into the injection port on the Dionex
ICS-1100 front door (see Figure 2-1) and pull out the plunger to draw
the sample into the injection valve.

5. Switch the injection valve to the Inject position (see Section 3.10.4).

3.10.3 Loading Samples with an Autosampler

1. Verify that the autosampler output line is connected to port s (5) of the
Dionex ICS-1100 injection valve.

2. Prepare and fill the sample vials and place them in the autosampler
tray or cassette. Refer to the autosampler manual for detailed
instructions.

3. The sample loading process depends on the autosampler. Refer to the
autosampler manual for detailed instructions. In general, use one of
the following methods:

= Include the commands for controlling sample loading in a
Chromeleon program. (If necessary, refer to the Chromeleon
Help or user manual for assistance.)

e Enter the commands for loading the sample on the autosampler
front panel.

4. Switch the injection valve to the Inject position (see Section 3.10.4).
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3.10.4 Injecting Samples

After loading the sample in the sample loop, use one of the following
methods to switch the injection valve to the Inject position:

Manually: Click the Inject button on the Chromeleon Control panel
(see Figure 3-4).
Automatically: Include the Inject command in a Chromeleon

program. (If necessary, refer to the Chromeleon Help or user manual
for assistance.)

3.11 Processing Samples

Samples can be run manually (one at a time) or else they can be grouped and run
automatically in batches.

3.11.1 Manual Sample Processing

To manually process a sample, select operating parameters and
commands from the Chromeleon panel tabset. Commands are executed as
soon as they are entered.

Summary of Manual Sample Processing

1.

Complete the instructions in Section 3.2 through Section 3.8 to
prepare the Dionex 1CS-1100 for operation and to prepare the sample
for processing.

Load the sample, using a syringe, vacuum syringe, or autosampler
(see Section 3.10).

On the Dionex ICS-1100 Control panel, click the Autozero button.

On the Sequence Control panel, click the Acq On button (or click
the Acquisition On/Off button on the Chromeleon toolbar).

Inject the sample (see Section 3.10.4).

The signal plot is displayed on the Control panel. Monitor the
chromatogram. When sample data has been collected, click the Acq
Off button on the Sequence Control panel (or click the Acquisition
On/Off button on the Chromeleon toolbar).
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Saving Manual Data

NOTE Chromeleon Xpress does not allow data to be saved.

If you are using Chromeleon, data from manual processing is saved in the
manual sequence under the timebase folder in the local datasource.

To save the data from a manual run:

1.

2
3.
4

Select the manual folder and select File > Save As.
Enter a new name for the sequence.

Select the Save raw data check box.

Click Save.

3.11.2 Automatic (Batch) Sample Processing

You can use Chromeleon or Chromeleon Xpress to create a list of samples
(a sequence) to be processed automatically. For each sample, the
sequence includes the following:

A program with commands and parameters for controlling the Dionex
ICS-1100 and autosampler (if used), and for acquiring sample data.

A quantification method for peak identification and area
determination.

Additional sample processing parameters (sample name, sample type,
injection volume, etc.).

After creating the sequence, you can start batch processing.
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Summary of Automatic Sample Processing

1. Complete the instructions in Section 3.2 through Section 3.8 to

prepare the Dionex 1CS-1100 for operation and to prepare the sample
for processing.

If an autosampler is installed, prepare and fill the sample vials and
place them in the autosampler tray or cassette. Refer to the
autosampler manual for detailed instructions. Autosampler manuals
are provided on the Thermo Scientific Reference Library DVD
(P/N 053891).

If an autosampler is not installed, load the sample into the injection
valve sample loop through the sample port on the Dionex 1CS-1100
front door (see Section 3.10.1).

Use the Application Wizard to specify a program and quantitation
method, and create a sequence:

a. On the Sequence Control panel, click Application Wizard.

b. Select an application template from the list (see Figure 3-8).

Chromeleon Application Wizard : Application Tool |z|@g|

Specify Suppreszor Type.
Chooze an application tool for generating Program and Method files.

& Application Templates

J 4 Production Test Chiomatogram
A5714 Production Test Chromatogran
T oo LA T 48 Production Test Chromatogram

et E ok Srep aiaton iy AS44-5C Production Test Chrarmatograrm
A53-HC Production T est Chromatogram
L5124 Production Test Chromatogram st

= mm i ol St s B T T T e e Sk i e Pt e A S AT R A B A et e

Figure 3-8. Application Wizard
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c. Click Next > and select the in a new sequence via Sequence
Wizard option.

d. Click Next > to go to the Sequence Wizard.

e. Complete the steps in the Sequence Wizard, adding the desired
number of samples and standards to the list. For help, click the
Help button on the Sequence Wizard page.

After you click Finish, a sequence is created and a program
appropriate for the selected application is copied to the sequence. If
you are using Chromeleon, a quantification method is also copied to
the sequence.

5. Load the sequence and start batch processing:
a. On the Sequence Control panel, click Load Sequence.
b. Select the sequence created in Step 4 and click Open.
c. Click Start Batch.

3.12 Maintenance

This section describes routine maintenance procedures that users may perform.
All other maintenance procedures must be performed by Thermo Fisher Scientific
personnel.

As Needed
= Regularly check the eluent reservoir and refill when needed.

e Make fresh eluent as needed.

e RFIC-ER systems only: The Chromeleon RFIC-ER Wellness feature tracks
the usage of the RFIC-ER eluent and columns. An Audit Trail message will
inform you when an item is approaching the end of its useful life span. You
can also check the life expectancy of these components on the RFIC-ER
Wellness panel.

Daily

e Check the Dionex 1CS-1100 component panel (see Figure 2-4) for leaks or
spills. Wipe up spills. Isolate and repair leaks (see Section 4.3). Rinse off any
dried eluent with deionized water.
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Check the waste container daily and empty when needed.

Weekly

Once a week, check fluid lines for crimping or discoloration. Replace any
pinched lines. Replace damaged lines.

Check the junctions between the pump heads and the pump casting for
evidence of liquid leaks. If the piston seal wash tubing is not connected, check
the drain tubes at the rear of the pump heads for evidence of moisture. Normal
friction and wear may gradually result in small liquid leaks around the piston
seal. If unchecked, these leaks can gradually contaminate the piston housing,
causing the pump to operate poorly. If leaks occur, replace the piston seals
(see Section 5.7).

Check the end-line filter (P/N 045987) and change if needed. When new, end-
line filters are pure white. If the system is in continuous operation, change the
end-line filter weekly, or whenever it becomes discolored. Replace the filter
more often if bacterial buildup is visible or if the eluent does not contain
solvent.

NOTE It is especially important to regularly replace end-line
filters when using aqueous eluents, which may
contaminate the filter with bacteria or algae. The
bacterial buildup may not be visible.

Every Six Months

Calibrate the cell (see Section 5.1.2).
Calibrate the vacuum degas assembly (see Section 5.1.4).

Replace the pump piston rinse seals and piston seals (see Section 5.7).

Yearly

Thermo Fisher Scientific recommends performing preventive maintenance
annually, as well as before scheduled Performance Qualification tests. A
Dionex ICS-1100 Preventive Maintenance Kit (P/N 057954) is available for
this purpose.

Rebuild the auxiliary valve, if installed (see Section 5.4).

If a Dionex AS Autosampler is installed, perform the preventive maintenance
procedure. The Dionex AS Preventive Maintenance Kit (P/N 060581) is
available for this purpose.
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= If a Dionex AS-DV Autosampler is installed, replace the tip and tubing. The
Dionex AS-DV Preventive Maintenance Kit (P/N 055647) contains all of the
components required to replace the sampling tip and the tubing between the
tip and the injection valve. Instructions are included with the kit.

Doc. 065289-03 10/12

57



Dionex ICS-1100 lon Chromatography System

58

Doc. 065289-03 10/12



4 « Troubleshooting

4.1

This chapter is a guide to troubleshooting minor issues that may arise during
operation of the Dionex ICS-1100. Turn to the section of this chapter that best
describes the operating problem or symptom that has been observed. Each section
lists possible causes of the problem or symptom in order of probability. A
systematic troubleshooting approach is the most effective way to determine the
root cause.

If you are unable to resolve a problem by following the instructions here, contact
Technical Support for Dionex products. In the U.S. and Canada, call 1-800-346-
6390. Outside the U.S. and Canada, call the nearest Thermo Fisher Scientific
office. Please have this chapter at hand when talking with Technical Support
personnel.

Error Messages

The Moduleware (the instrument control firmware installed in each Dionex ICS-
1100 module) periodically checks the status of certain parameters. If a problem is
detected, it is reported to Chromeleon and logged in the Audit Trail. Each error
message is preceded by an icon that identifies the seriousness of the underlying
problem (see the table below). You can change the severity level assigned to a
problem whenever appropriate.

Icon Severity Level Description

'CD Warning A message is displayed in the Audit Trail, but the
current run is not interrupted.

.dl Error A message is displayed in the Audit Trail, and the
system attempts to correct the problem (sometimes
by using an alternative parameter). An Error never
interrupts the current analysis; however, if it occurs
during the Ready Check, the analysis will not be
started.

@ Abort A message is displayed in the Audit Trail, and the
running batch is aborted.
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The table below lists the most frequently observed Dionex 1CS-1100 error
messages. For troubleshooting assistance, refer to the page indicated in the table.

Alarms and Error Conditions

Column heater exceeds safe temperature
Column heater open circuit

Column heater short circuit

Degas calibration failed

Hardware not present

Leak sensor wet

Load/Inject valve error

Option not installed

Pressure slope calibration error

Pump motor lost control

Pump over pressure

Pump pressure hardware error

Pump stopped due to lost USB communication error
Pump under pressure

Second valve error

Suppressor not connected

Suppressor over current

Suppressor over power

Suppressor over voltage

Suppressor stopped for zero flow rate

Table 4-3. Alarms and Error Messages Summary

See

page 61
page 61
page 61
page 61
page 62
page 62
page 62
page 63
page 63
page 63
page 64
page 64
page 64
page 65
page 65
page 66
page 66
page 67
page 67
page 67
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4.2 Troubleshooting Error Messages

@ COLUMN HEATER EXCEEDS SAFE TEMPERATURE

This error occurs when the column heater temperature is higher than the
maximum allowed. This error may occur if the Dionex ICS-1100 is operating
in an extreme environment (greater than 40 °C (104 °F)).

To troubleshoot:

Refer to Section A.3 for environmental specifications.

@ COLUMN HEATER OPEN CIRCUIT
This error occurs when the column heater is unplugged from the component
panel.
To troubleshoot:
1. Check that the column heater is plugged into the component panel.

2. If the error persists, the column heater may be faulty. Replace the column
heater (see Section 5.12).

@ COLUMN HEATER SHORT CIRCUIT

This error occurs when there is a short circuit on the thermistor input used to
measure the column heater temperature. This error indicates a faulty column
heater.

To troubleshoot:

Replace the column heater (see Section 5.12).

{E‘ DEGAS CALIBRATION FAILED

This error occurs when the degas vacuum does not reach the expected level
during calibration.
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To troubleshoot:
1. Retry the calibration.

2. If calibration still fails, the vacuum degas assembly may need to be
replaced. Contact Thermo Fisher Scientific for assistance.

HARDWARE NOT PRESENT

This error indicates a problem in the Dionex ICS-1100 electronics.
To troubleshoot:

Contact Thermo Fisher Scientific for assistance. The Dionex ICS-1100
electronics components cannot be serviced by the user.

LEAK SENSOR WET

The leak sensor is installed in the drip tray at the bottom of the component
panel (see Figure 2-4). If liquid accumulates in the tray, the sensor signals the
problem and this error message appears.

To troubleshoot:

1. Locate the source of the leak by visually inspecting the tubing, fittings,
and components on the component panel. Refer to Section 4.3.

2. Tighten fittings or replace tubing and fittings as required. Refer to
Section 4.3 for detailed troubleshooting of various types of leaks.

3. After fixing the leak, dry the drip tray thoroughly to prevent the leak
sensor from triggering additional error messages.

LOAD/INJECT VALVE ERROR

If the injection valve fails to switch position within 1 second of being toggled,
the Dionex ICS-1100 Moduleware reports an error to Chromeleon and this
error message appears.
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To troubleshoot:

1. If asequence is being executed, terminate the sequence by selecting
Batch > Stop in Chromeleon.

2. Try to toggle the valve from Load to Inject by clicking the Load and
Inject buttons on the Dionex 1CS-1100 Control panel in Chromeleon.

Turn off the Dionex 1CS-1100 power briefly and then restart.
4. If the problem persists, repeat Step 2.

5. If the problem persists, contact Thermo Fisher Scientific for assistance.

.ﬂh OPTION NOT INSTALLED
This error occurs if a command is issued to control an option that is not
installed.
To troubleshoot:

Check the Chromeleon Server Configuration program to verify that the option
is enabled.

@ PRESSURE SLOPE CALIBRATION ERROR

This error occurs if you try to calibrate the pressure slope when the pressure is
less than 3 MPa (500 psi).

To troubleshoot:

Contact Thermo Fisher Scientific for assistance.

{E‘ PUMP MOTOR LOST CONTROL

This error indicates a problem in the pump controller electronics.
To troubleshoot:

Contact Thermo Fisher Scientific for assistance. The Dionex ICS-1100
electronics components cannot be serviced by the user.
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@ PUMP PRESSURE HARDWARE ERROR

This error indicates a problem in the pump controller electronics.
To troubleshoot:

Contact Thermo Fisher Scientific for assistance. The Dionex ICS-1100
electronics components cannot be serviced by the user.

PUMP OVER PRESSURE

If the system pressure exceeds the set limit for at least 0.5 second, this error
message appears and the pump stops. Pressure limits can be set in the
Chromeleon Server Configuration or in the control program.

To troubleshoot:

1. Check for blockages in the liquid lines by working your way backward
from the cell to the pump. See Section 2.2 for the system flow schematics.

2. Check that the flow rate is set to the correct value.
3. Check that the high pressure limit is set to the correct value.

4. Restart the pump.

PUMP STOPPED DUE TO LOST USB COMMUNICATION
ERROR

This error occurs if the Dionex 1CS-1100 loses communication with
Chromeleon.
To troubleshoot:

Verify that the USB cable is connected correctly from the Dionex 1CS-1100
rear panel to the Chromeleon PC.
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@ PUMP UNDER PRESSURE

If the system pressure falls below the low pressure limit, the pump stops and
this error message appears. Pressure limits can be set in the Chromeleon
Server Configuration or in the control program.

To troubleshoot:

1.

2
3
4.
5

Make sure the eluent reservoir is full.
Check for liquid leaks (see Section 4.3).
Check that the waste valve is closed.
Prime the pump (see Section 5.16).
Restart the pump.

@ SECOND VALVE ERROR

If the auxiliary valve fails to switch position within 1 second of being toggled,
the Dionex 1CS-1100 Moduleware reports an error to Chromeleon and this
error message appears.

To troubleshoot:

1.

If a sequence is being executed, terminate the sequence by selecting
Batch > Stop in Chromeleon.

Try to toggle the valve from position A to position B by clicking the
corresponding buttons on the Dionex 1CS-1100 Control panel in
Chromeleon (or by clicking the Valve_2 commands under Pump_ECD in
the Commands dialog box).

Turn off the Dionex 1CS-1100 power briefly and then restart.
If the problem persists, repeat Step 2.

If the problem persists, contact Thermo Fisher Scientific for assistance.
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{E} SUPPRESSOR NOT CONNECTED
This error occurs if you turn on the suppressor and the Dionex ICS-1100
cannot establish a connection with the suppressor.
To troubleshoot:
1. Check the suppressor cable connection (see Section 5.11).

2. Ifthe error persists, contact Thermo Fisher Scientific for assistance. There
may be a problem in the suppressor controller electronics. The Dionex
ICS-1100 electronics components cannot be serviced by the user.

@ SUPPRESSOR OVER CURRENT
This error may be caused by an expended or dirty suppressor or by a
malfunction in the suppressor controller electronics.
To troubleshoot:

1. Follow the instructions in the suppressor manual to regenerate the
suppressor. Suppressor manuals are included on the Thermo Scientific
Reference Library DVD (P/N 053891).

2. Follow the instructions in the suppressor manual to clean the suppressor.

3. Ifamalfunction in the suppressor controller is suspected, contact Thermo
Fisher Scientific for assistance. The Dionex 1CS-1100 electronics
components cannot be serviced by the user.
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@ SUPPRESSOR OVER POWER

This error occurs when, in order to maintain the selected current, the Dionex
ICS-1100 is required to apply a higher voltage than the suppressor can
support.

To troubleshoot:
1. Reduce the flow rate.

2. Rehydrate the suppressor. Refer to the suppressor manual for instructions.
Suppressor manuals are included on the Thermo Scientific Reference
Library DVD (P/N 053891).

3. If the error persists, replace the suppressor (see Section 5.11).

@ SUPPRESSOR OVER VOLTAGE
This error occurs if you turn on the suppressor but the Dionex 1CS-1100
cannot establish a connection with the suppressor.
To troubleshoot:
1. Check the suppressor cable connection (see Section 5.11).
2. If the error persists, replace the suppressor (see Section 5.11).

{E‘ SUPPRESSOR STOPPED FOR ZERO FLOW RATE

This error message appears when you click the Shutdown button on the
Dionex 1CS-1100 Control panel in Chromeleon. The message also appears
anytime you turn off the pump flow while the suppressor is on. The
suppressor is automatically turned off to prevent damage to the suppressor.

To troubleshoot:

= If the pump stopped unexpectedly, see Section 4.6 for pump
troubleshooting information.
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4.3

Liquid Leaks

Leaking fitting

Locate the source of the leak. Tighten or, if necessary, replace the liquid line
connection (see Section 5.3). Refer to Installation of Dionex Liquid Line
Fittings (Document No. 031432) for tightening requirements. The manual is
included on the Thermo Scientific Reference Library DVD (P/N 053891).

Broken liquid line

Replace the line and fittings with the same length and internal diameter tubing
(see Section 5.3).

Blocked or improperly installed line

Make sure the lines are not crimped or otherwise blocked. Also, if the blocked
line is a waste line, make sure it is not elevated at any point after it exits the
Dionex ICS-1100. If a line is blocked, replace it (see Section 5.2).

Loose pump check valve

1. Make sure the check valves are firmly seated in the pump head. If they are
not, tighten them carefully with an open-end wrench just until the leak
stops.

2. If the leak persists, replace the check valve (see Section 5.6).
Leaking seal wash port

Leaking from the seal wash port indicates a leaking piston seal. Replace the
seal (see Section 5.7).

Damaged pump piston seal

1. Replace the piston seal (see Section 5.7).

2. If the leak persists, replace the piston (see Section 5.8).
Pump head not tight against casting

Carefully tighten the pump head mounting nuts just until the leak stops. DO
NOT OVERTIGHTEN!
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e Leaking pressure transducer

1. Make sure the liquid line connections into the pressure transducer are
tight. Refer to Installation of Dionex Liquid Line Fittings (Document No.
031432) for tightening requirements. The manual is included on the
Thermo Scientific Reference Library DVD (P/N 053891). Replace any
damaged fittings.

2. If the pressure transducer continues to leak, contact Thermo Fisher
Scientific for assistance. The pressure transducer cannot be serviced by
the user.

e Leaking pump head waste valve

Make sure the waste valve is closed. To close the valve, turn the knob
clockwise, and tighten fingertight. DO NOT OVERTIGHTEN!
Overtightening may damage the valve and the pump head.

If the leak persists, replace the waste valve O-ring (see Section 5.9).
e Leaking suppressor

Refer to the suppressor manual for troubleshooting procedures. Suppressor
manuals are included on the Thermo Scientific Reference Library DVD
(P/N 053891).

= Leaking injection valve or auxiliary valve

1. Make sure the liquid line connections to the transducer are tight. Refer to
Installation of Dionex Liquid Line Fittings (Document No. 031432) for
tightening requirements. The manual is included on the Thermo Scientific
Reference Library DVD (P/N 053891). Replace any damaged fittings.

2. Liquid leaks from behind the valve stator may indicate a scratched rotor
seal. Rebuild the valve (see Section 5.4).

* Leaking detector cell

1. Check the waste lines for blockage; trapped particles can plug the lines
and cause a restriction and/or leak. If necessary, clear the waste lines by
reversing the direction of flow.

2. Make sure the plumbing downstream from the cell is clear; a blockage
may overpressurize the cell, causing it to leak. If the problem continues,
contact Thermo Fisher Scientific for assistance.
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4.4

Pump Difficult to Prime or Loses Prime

Excessive pressure fluctuations (more than 3% difference from one pressure
reading to the next) indicate that the pump is out of prime.

Empty eluent reservoir and/or no eluent connected

Fill the reservoir. Make sure all connections are secure.

Eluent improperly or insufficiently degassed

If the Dionex ICS-1100 does not contain a vacuum degas assembly, degas the
eluent manually (see Section 3.4.4).

If the Dionex 1CS-1100 contains a vacuum degas assembly, check the degas
settings:

1.

Open the Chromeleon Server Configuration program. Right-click the
Dionex ICS-1100 device in the timebase and select Properties.

Select the Options tab (see Figure 4-1).

Dionex ICS-1100 IC System X
Solvents ] State Devices ] Inject Valve ] Error Levels ] Demo Chramatogram ]
TTL Inputz ] Trend ] Calibration ] Diagnostics
General Dptioris l Signals ] Head Tupe & Limits ]

v Degas
" Always OFf
" Always On
" Cycle
f* Monitor

On: [0.120 sec) Oiff: [0..5940 sec)

IV Column Heater

[ Walve 2
RFICER
Link to ERC Contraller: <Mone:> j
] 4 | Cancel | | Help |

Figure 4-1. Dionex ICS-1100 Server Configuration Properties: Options
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3. Verify that the Degas check box is selected.

4. Check the Degas settings. Select either the Monitor option or the
Cycle option. If you select Cycle, set the time On to 30 seconds and
the time Off to 600 seconds. If Cycle is already selected, try
increasing the time on or decreasing the time off.

e End-line filter is dirty or clogged

When new, end-line filters (P/N 045987) are pure white. If the system is in
continuous operation, change the end-line filter weekly, or whenever it
becomes discolored. Replace the filter more often if bacterial buildup is
visible or if the eluent does not contain solvent.

NOTE It is especially important to regularly replace end-line
filters when using aqueous eluents, which may
contaminate the filter with bacteria or algae. The
bacterial buildup may not be visible.

* Blockages in inlet tubing

Kinked or clogged tubing causes the pump to be “starved” for eluent. Replace
the tubing and fittings (see Section 5.3).

= Dirty check valve
Clean or replace the pump check valve (see Section 5.6).
* Liquid leaks at junction between pump head and pump casting

Use the open-end wrench (P/N 014605) provided in the Dionex ICS-1100
Ship Kit (P/N 057905) to tighten the two acorn nuts that attach the pump head
to the pump housing (see Figure 5-7). Tighten the nuts evenly (12 in-lb
torque).

If the leak persists, replace the piston seal (see Section 5.7).
e Liquid leaks from the seal wash port

Replace the piston seal (see Section 5.7).
e Scratched pump piston

Check the pump pistons for scratches and replace if necessary (see
Section 5.8).

Doc. 065289-03 10/12 71



Dionex ICS-1100 lon Chromatography System

4.5 Pump Does Not Start

e No power (front Power LED indicator is not lit)

Check that the power cord is plugged in.

Check the main power fuses and replace, if needed (see Section 5.18).
* No communication between Dionex 1CS-1100 and Chromeleon

Verify that the USB cable is connected correctly. For connection and setup
information, refer to the Dionex ICS-1100 installation instructions.

e Pump is turned off
Turn on the pump from the Dionex ICS-1100 Control panel in Chromeleon.
e Flowrateissetto0

Set the flow rate from the Dionex 1CS-1100 Control panel in Chromeleon.

46 No Flow

e Pump waste or priming valve open (see Figure 4-2)

Close the valves by turning the knobs clockwise until fingertight. DO NOT
OVERTIGHTEN! Overtightening may damage the valve and the pump
head.

Waste Valve — — Priming Valve

Figure 4-2. Waste and Priming Valves
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4.7

4.8

Flow rate is set to 0
Set the flow rate from the Dionex 1CS-1100 Control panel in Chromeleon.
Eluent valve is closed

Open the eluent valve from the Dionex ICS-1100 Control panel in
Chromeleon.

Pump not primed

Prime the pump (see Section 5.17).
Broken pump piston

Replace the piston (see Section 5.8).

Erratic Flow/Pressure Reading

Pump needs priming

Prime the pump (see Section 5.17).

Damaged piston seal

Replace the piston seal (see Section 5.7).

Dirty pump check valve

Clean or replace the check valve (see Section 5.6).
Leaking liquid lines or fittings

Check the liquid lines and fittings for small leaks. Tighten or, if necessary,
replace the liquid line connection (see Section 5.3). Refer to Installation of
Dionex Liquid Line Fittings (Document No. 031432) for tightening
requirements. The manual is included on the Thermo Scientific Reference
Library DVD (P/N 053891).

Excessive System Backpressure

Restriction in the system plumbing

Check all liquid lines for crimping or blockage. Make sure the ferrule fittings
are not overtightened onto tubing. Refer to Installation of Dionex Liquid Line
Fittings (Document No. 031432) for details. The manual is included on the
Thermo Scientific Reference Library DVD (P/N 053891).
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4.9

If you have trouble isolating the restriction, refer to Section 5.2.
Plugged or damaged fitting

Isolate the faulty fitting by loosening fittings, one by one, until the pressure
returns to normal. Repair or replace the fitting (see Section 5.3).

Flow rate through the columns too high

Set the correct rate for your application. If an incorrect flow rate calibration is
suspected, calibrate the flow (see Section 5.1.3).

Clogged column bed supports

Refer to the instructions in the column manual for troubleshooting guidance.
Column manuals are included on the Thermo Scientific Reference Library
DVD (P/N 053891).

Contaminated columns

Clean the columns as instructed in the column manual or replace the guard
column.

Plugged injection valve or auxiliary valve passages
Rebuild the valve (see Section 5.4).

Peak “Ghosting”

“Ghosting” is the appearance of extraneous peaks in a chromatogram. These may
be late-eluting peaks from a previous injection. They may also be the result of a
contaminated standard or eluent, or a malfunctioning injection valve. These peaks
may co-elute with peaks of interest, resulting in nonreproducible peak
heights/areas.

Insufficient time between sample injections

Wait until the previous sample has been completely eluted before making
another injection.

Insufficient flush between samples

Flush the sample loop with at least 10 loop volumes of deionized water or
sample between sample injections.

Incorrect or contaminated standards

Remake standards.
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Incorrect or contaminated eluent

Remake the eluent. If the system is not operating in the RFIC-ER mode, refer
to the instructions in the column manual. The manual is included on the
Thermo Scientific Reference Library DVD (P/N 053891).

If this is an RFIC-ER system, refer to the instructions in the manual provided
in your RFIC-ER Installation Kit.

Install or replace the end-line filter on the end of the deionized water line (see
Section 3.4.3).

Malfunctioning injection valve or auxiliary valve
1. Rebuild the valve (see Section 5.4).
2. If the valve leak persists, contact Thermo Fisher Scientific for assistance.

4.10 Nonreproducible Peak Height or Retention Time

Column overloading

Dilute the sample (see Section 3.9.3).

Liquid leaks

Locate and eliminate the leaks (see Section 4.3).

Incomplete or imprecise filling of the sample loop

1. Fill the sample loop until excess sample exits the waste line.
2. Inspect the 1-cc syringe (P/N 016388) and replace if damaged.
Pump not primed properly

Prime the pump (see Section 5.17).

4.11 Abnormal Retention Time or Selectivity

Incorrect or contaminated eluent

Remake the eluent, using concentrated eluent and ASTM filtered, Type I (18-
megohm) deionized water.
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Contaminated or degraded sample

Take appropriate precautions when preparing and storing samples to prevent
contamination and degradation (see Section 3.9).

Contaminated column

1. Clean the column as instructed in the column manual. Column manuals
are included on the Thermo Scientific Reference Library DVD
(P/N 053891).

2. If cleaning is unsuccessful, replace the column.

4.12 No Cell Response

Cell not properly installed

Verify that the cell front cover is flush against the component panel. If
necessary, tighten the two mounting screws. When the cell is correctly
installed and the screws tightened, an electronics connector on the cell plugs
into a receptacle inside the Dionex 1CS-1100.

No flow from pump

This condition has several possible causes; see Section 4.5 and Section 4.6 for
details.

Cell electronics malfunctioning

Use the Chromeleon Wellness Panel diagnostics to test the electronics (see
Section 5.1 and the Chromeleon Help for instructions). If the variance reading
is outside the tolerance range (less than 1 uS), the electronics are
malfunctioning. Contact Thermo Fisher Scientific for assistance. The Dionex
ICS-1100 electronics cannot be serviced by the user.

4.13 High Cell Output

Background not suppressed by suppressor

Verify that the suppressor is turned on and the current is set to the correct
value. Refer to the suppressor manual for additional troubleshooting
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guidance. Suppressor manuals are included on the Thermo Scientific
Reference Library DVD (P/N 053891).

Sample concentration too high

Dilute the sample (see Section 3.9.3).

Wrong eluent

Check that you are using the correct eluent for your application.

RFIC-ER systems only: Replace the RFIC-ER columns, if necessary. An
Audit Trail message will inform you when a column is approaching the end of
its useful life span. You can also check the life expectancy of the columns on
the RFIC-ER Wellness panel.

Background conductivity not offset from conductivity reading

Before making an injection, allow the background conductivity to equilibrate,
and then click Autozero on the Dionex ICS-1100 Control panel in
Chromeleon.

Cell out of calibration

Recalibrate the cell (see Section 5.1.2).
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4.14

Baseline Noise or Drift

* Flow system leak; erratic baseline

Check all fittings and liquid lines for leaks. Tighten or, if necessary, replace
all liquid line connections. Refer to Installation of Dionex Liquid Line Fittings
(Document No. 031432) for tightening requirements. The manual is included
on the Thermo Scientific Reference Library DVD (P/N 053891).

e Trapped gases

Release any trapped gases in the cell by loosening the lines to and from the
cell and then retightening them. Also loosen and retighten the fittings to and
from the suppressor eluent ports.

e Pump not properly primed
Prime the pump (see Section 5.17).
e Contaminated or incorrect eluent

Remake the eluent, using concentrated eluent and ASTM filtered, Type I (18-
megohm) deionized water.

RFIC-ER systems only: Replace the RFIC-ER columns, if necessary. An
Audit Trail message will inform you when a column is approaching the end of
its useful life span. You can also check the life expectancy of the columns on
the RFIC-ER Wellness panel.

e Rapid changes in ambient temperature
Make sure the ambient temperature is between 4 and 40 °C (40 and 104 °F).

Make sure air conditioning and heating vents are directed away from the
Dionex ICS-1100 and the Dionex 1CS-1100 front door is closed.

* Insufficient system equilibration following changes to operating
parameters; especially apparent when operating at high sensitivities

Allow a longer system equilibration time (up to 2 hours) before starting
operation.

= Incorrect suppressor operating conditions

Refer to the suppressor manual for troubleshooting information. Suppressor
manuals are included on the Thermo Scientific Reference Library DVD
(P/N 053891).
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e Cell above or below temperature

Contact Thermo Fisher Scientific for assistance.
e Damaged piston seal

Replace the piston seal (see Section 5.7).

4.15 Vacuum Degas Assembly Does Not Run

= Degas option not enabled in Chromeleon

1. Open the Chromeleon Server Configuration program. Right-click the
Dionex 1CS-1100 device in the timebase and select Properties.

2. Select the Options tab (see Figure 4-3).

Dionex ICS-1100 IC System X

Solvents ] State Devices ] Inject Yalve ] Error Levels ] Demo Chromatogram ]
TTL Inputz ] Trend ] Calibration ] Diagnostics ]
General Options l Signals ] Head Type & Limits ]

¥ Degas
€ Always Off
" Always On

" Cycle Or: [0.120 gec) Off: [0..5940 sec)

{* honitor

[ Calumn Heater

[ Walve 2

RFIC-ER
Link to ERC Contraller: <Mones j

Ok | Cancel | | Help |

Figure 4-3. Dionex ICS-1100 Server Configuration Properties: Options

3. Verify that the Degas check box is selected.
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4.

6.

Under Degas, verify that the Always Off option is not selected. If it is,
select one of the following settings instead:

* Cycle; also select On: 30 seconds and Off: 10 minutes
e Monitor

If the Degas settings are correct, but the degas assembly still does not run,
test the assembly by selecting the Always On option. The pump should
turn on immediately. If it does not, the vacuum degas assembly may need
to be replaced. Contact Thermo Fisher Scientific for assistance.

Select the Degas, Always On option only when testing the vacuum degas
assembly. Do not select the Always On option for routine use.

If the degas pump runs when you select Always On, but does not run
when Monitor is selected, recalibrate the degas assembly (see
Section 5.1.4).
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This chapter describes Dionex 1CS-1100 service and repair procedures that the
user can perform. All procedures not included here, including electronics-related
repair procedures, must be performed by Thermo Fisher Scientific personnel. For
assistance, contact Technical Support for Dionex products. In the U.S. and
Canada, call 1-800-346-6390. Outside the U.S. and Canada, call the nearest
Thermo Fisher Scientific office.

Before replacing any part, refer to the troubleshooting information in Chapter 4 to
isolate the cause of the problem.

IMPORTANT Substituting non-Dionex/Thermo Fisher Scientific parts may impair

5.1

performance, thereby voiding the product warranty. Refer to the
warranty statement in the Dionex Terms and Conditions for more
information.

Diagnostic and Calibration Procedures
Diagnostic and calibration procedures are performed from the Chromeleon
Wellness Panel (see Figure 5-1).

For an overview of the Wellness Panel features, see Section 5.1.1. For instructions
on performing calibration and diagnostic procedures, see the following sections:

e Calibrating the Conductivity Cell (Section 5.1.2)
= Calibrating the Flow Rate (Section 5.1.3)
e Calibrating the Vacuum Degas Assembly (Section 5.1.4)
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5.1.1 Chromeleon Wellness Panel Overview

NOTE Do not open a System Wellness Control panel if the
name includes “Service.pan.” These Wellness panels are
reserved for use by Thermo Fisher Scientific Service
Representatives.

To Open the Wellness Panel

1. Inthe Chromeleon Browser, expand the Dionex
Templates\Panels\Wellness folder.

2. Double-click ICS-1100_1600 2100 Wellness_user.pan.

The Wellness Panel opens (see Figure 5-1). If the controls on the
Wellness panel are disabled, select Control > Connect to timebase
and then select the Dionex ICS-1100 timebase.

¥ ICS-1100 Wellness Panel - IC5-1100_Timebase - CMADLER1

1CS-1100 System Stat Audit Trail
¥ Connected | ‘1_ 4‘:|i|>|-'|tin||| ‘ Diagnostic ‘ @11:06:27 AM {Pump_ECD} The ERC 10 is linked to the module. ~
Pump (T111:08:27 A {Pump_ECD} Please verify the salvent and waste level values!
__— . . #11:06:28 AM Manually acquired samples will be stored temporarily in
Calibration Detalls; _Details... || on | o | sequence "SEQ:ACMADLER locahCS-1100_Timebasetmanual” v
~ :

Update Wellness Datahase————————— (Degas Calibration Conductivity Cell Temperature Calibration—

Press for instructions: Instructions Press for instructions: Instructions Press for instructions: Instructions
Upload Degas Calibration: Calibrate Set Cell Temp to 35 °C: Cell 35°C

Pump Flow Rate Calibration————— | Log Calibration Value: Log Set Flow Rate to 1.00: 1.00 mL/min

[P o Qi sy M Degas Pressure: D Total Conductivity: 0.122 ps
geestilaE el M Current Cal. Date: l:l Cond. Cell Calibration: Calibrate
Set Flow Rate to 1.00: 1.00 mL/min Last Calibration Date: I:I

Log Calibration Value: Log
Current Pump Pressure: 800 psi Current Calibration Date; 3772009
5.00 minute timer: 5.00 min _—
Q Electric Conductivity Cell Calibration Last Calibration Date: 37772009
Enter new Flow Rate Cal: 5049 : Press for instructions: Instructions

Store Calibration Value: Calibrate Conductivity Cell Offset Cal:  Offset Cal. Dummy Cell Test
Log Calibration Value: Log Conductivity Cell Slope Cal:  Slope Cal. Press for instructions: Instructions
9

Current Calibration Date: 3/7/2009 Current Calibration Date: @D“""“Y Cell:

Last Calibration Date: 37712009 Last Calibration Date: Log Dummy Cell Value: Log

RERE

=
=
E

d

Figure 5-1. Chromeleon Wellness Panel
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Use the Wellness Panel to perform the following functions:

Calibrate the pump flow rate

Calibrate the vacuum degas assembly

Calibrate the conductivity cell

Test the conductivity cell electronics, using a dummy cell

Upload calibration values from the Dionex 1CS-1100 to the
Chromeleon Wellness database
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5.1.2

Calibrating the Conductivity Cell

When to Calibrate

After every 6 months of use

NOTE Do not use this procedure to calibrate a new cell. If you

are replacing a cell, see the instructions in Section 5.10
to install the new cell and calibrate it.

Items Needed Description
1.0 mM KClI solution Prepare by dissolving 0.07456 g of reagent-
grade KCl in 1 liter of 18-megohm DI
water.
Backpressure tubing to provide  Use 0.076-mm (0.003-in) ID yellow PEEK
at least 7 MPa (1000 psi) tubing (P/N 049715).
1. Open the Dionex 1CS-1100 Wellness Panel in Chromeleon (see

10.

Section 5.1.1).

On the Wellness Panel under Electric Conductivity Cell
Calibration, click Offset Cal.

When the offset calibration is complete, click Slope Cal on the
Wellness Panel.

Disconnect the pump output line from the injection valve.

Disconnect the line from the suppressor ELUENT OUT port to the cell
inlet and connect the pump output line directly to the cell inlet.

Disconnect the line from the suppressor REGEN IN port to the cell
outlet. Direct the cell outlet line to a waste container.

Verify that the backpressure is at least 7 MPa (1000 psi).

On the Wellness Panel under Conductivity Cell Calibration, click
Cell 35 °C. Allow the cell to reach this temperature, and then wait an
additional 5 minutes to let it stabilize.

Select 1.00 mL/min to begin pumping 1.00 mM KCI through the cell
at 1.0 mL/min.

Wait until the total conductivity reading stabilizes (in about
15 minutes) and then select Calibrate on the Wellness Panel.
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After calibration, the conductivity reading should be 147.00 + 2 uS
and the cell constant should be between 120 and 180. If this is not the
case, contact Thermo Fisher Scientific for help.

11. Click Log to record the new calibration values in the Audit Trail.

12. Flush the KCI solution from the system by pumping deionized water
through the cell. When the conductivity drops to less than 1 uS/cm,
stop the pump.

13. Reconnect the pump to the injection valve and reconnect the line
from the suppressor ELUENT OUT port to the cell inlet.

14. Reconnect the cell outlet to the suppressor REGEN IN port.
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5.1.3 Calibrating the Flow Rate

When to Calibrate

If you run the Dionex 1CS-1100 Operational Qualification or Performance
Qualification and it fails.

Items Needed

0.076-mm (0.003-in) ID yellow PEEK tubing (P/N 049715) to create
14 + 2 MPa (2000 + 300 psi) of backpressure (if needed)

High purity ASTM filtered, Type I (18 megohm-cm) deionized water
Balance capable of weighing more than 10 g with 0.001 g readability

Tared beaker

To Calibrate
1. Open the Dionex ICS-1100 Wellness Panel in Chromeleon (see
Section 5.1.1).
2. Verify that there is 14 + 1.4 MPa (2000 * 200 psi) of backpressure.
3. On the Chromeleon Wellness Panel under Pump Flow Rate
Calibration, select Reset Cal.
4. Select 1 mL/min to set the flow rate and begin pumping deionized
water.
5. Allow the pump to stabilize for 20 minutes.
6. Click 5.00 min to start the timer. Immediately start collecting water
into the tared beaker.
7. Collect the water for exactly 5.00 minutes.
8. Enter the weight of the water (in grams).
9. Click Calibrate to download the value to the Dionex 1CS-1100.
10. To recheck the value, wait at least 15 minutes, and then repeat the
calibration.
11. Click Log to record the new calibration value in the Audit Trail.
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5.1.4 Calibrating the Vacuum Degas Assembly

When to Calibrate

e After every 6 months of use

1. Open the Dionex 1CS-1100 Wellness Panel in Chromeleon (see
Section 5.1.1).

2. On the Wellness Panel under Degas Calibration, select Calibrate.
The degas pump runs for 90 seconds to allow a vacuum to be created.
After 90 seconds, the vacuum degas pressure reading is recorded.
When the vacuum degas assembly is running in monitor mode, this
calibration value is used to determine when to turn on the degas

pump.
3. Click Log to record the new calibration value in the Audit Trail.

5.2 Isolating a Restriction in the Liquid Lines

A restriction in the liquid plumbing will cause excessive system backpressure.
1. Begin pumping eluent through the system (including the columns).

2. Follow the flow schematics in Figure 5-2 or Figure 5-3 and work backward
through the system, beginning at the suppressor Regen Out port. One at a
time, loosen each fitting and observe the pressure. The connection at which
the pressure drops abnormally indicates the point of restriction.

NOTE The numbers on the flow schematics indicate the order
in which liquid flows through the system components.

If the restriction has caused such high pressure that the system cannot be
operated, you must work forward through the flow schematic, adding parts
one at a time until an abnormal pressure increase (and hence, the restriction) is
found.

3. If the restriction is in the tubing or fitting, remove the restriction by back
flushing or by replacing the tubing or fitting (see Section 5.3).
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Figure 5-2. Dionex ICS-1100 Flow Schematic: Standard Configuration
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Figure 5-3. Dionex ICS-1100 Flow Schematic: RFIC-ER Mode
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5.3 Replacing Tubing and Fittings

The Dionex ICS-1100 is plumbed with the tubing and tubing assemblies listed

b

elow.

Tubing Size and Type

0.125-mm (0.005-in) ID PEEK  Red
(PIN 044221)

0.25-mm (0.010-in) ID PEEK Black
(P/N 042690)

0.50-mm (0.020-in) ID PEEK Orange
(P/N 042855)

0.75-mm (0.030-in) ID PEEK Green
(P/N 044777)

1.58-mm (0.062-in) ID PTFE Clear
(P/N 014157)

25 L sample loop Orange

(P/N 042857)

Color

Used For

Connection from pump pulse damper
to pressure transducer

Connections between other system
components

Connection from injection port to
injection valve

Connection from injection valve to
waste

Connection from pump to degas or
eluent reservoir; pump waste

Connection between ports L (1) and
L (4) on the injection valve

The ER Tubing Kit (P/N 070061) contains the four pieces of tubing required
for connections from the RFIC-ER columns to the component panel. This
tubing is initially installed in the Dionex ICS-1100 at the factory.

10-32 fittings (P/N 043275) and ferrules (P/N 043276) are used for most
tubing connections. For tightening requirements, refer to Installation of
Dionex Liquid Line Fittings (Document No. 031432). The manual is included
on the Thermo Scientific Reference Library DVD (P/N 053891).

1/8-in fittings (P/N 052267) and ferrules (P/N 048949) are used for
connections to the suppressor REGEN OUT port and the eluent reservoir.

90
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5.4 Rebuilding the Injection Valve or Auxiliary Valve

Thermo Fisher Scientific recommends rebuilding the injection valve and the
auxiliary valve (if installed) annually. The Injection Valve Rebuild Kit (P/N
057896) contains all required replacement parts for one valve.

NOTE If you prefer, you can replace the auxiliary valve “pod,”
instead of rebuilding the valve. Replacing the pod is
easier and faster than rebuilding the auxiliary valve. For
instructions, see Section 5.5.

IMPORTANT Substituting non-Dionex/Thermo Fisher Scientific parts may impair
performance, thereby voiding the product warranty. Refer to the

warranty statement in the Dionex Terms and Conditions for more
information.

Turn off the pump from the Dionex 1CS-1100 Control panel in Chromeleon.
Open the Dionex ICS-1100 front door.

Disconnect each liquid line connected to the valve.

> L np e

Follow the instructions provided in the Rebuild Kit to replace the rotor seal,
isolation seal, and stator face.

5. Reconnect all liquid lines to the injection valve (see Figure 5-4) or auxiliary
valve.

6. Close the door.

7. Turn on the pump.
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SAMPLE IN

(from door \\
inject port or
autosampler) O

25-uL
SAMPLE LOOP
TO INJ
(Orange) VALVE -c (Black)

.

TO INJ
VALVE -W

| (Green)

TO INJECT | (Green)
VALVE -P

Figure 5-4. Injection Valve Plumbing

5.5 Replacing an Auxiliary Valve Pod

This procedure describes how to replace the mechanical part (the “pod”) of the
optional auxiliary valve. This procedure is an alternative to rebuilding the valve
(see Section 5.4).

NOTE If the valve electronics require service, contact Thermo
Fisher Scientific. Electronics-related repair procedures
must be performed by Thermo Fisher Scientific
personnel.

Substituting non-Dionex/T_h_ermo Fisher Scientific parts may impair
performance, thereby voiding the product warranty. Refer to the
warranty statement in the Dionex Terms and Conditions for more
information.

1. Turn off the pump flow from the Dionex ICS-1100 Control panel in
Chromeleon.

2. Open the Dionex ICS-1100 front door.

3. Disconnect each liquid line connected to the valve.
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4. Unscrew the black locking ring
on the front of the valve (see
Figure 5-5) and remove the
ring.

5. Grasp the front of the valve pod
and pull firmly to remove it

from the Dionex 1CS-1100. Black

Locking Ring

Figure 5-5. Unscrew the Valve Locking Ring

6. Check that the new pod (6-port, P/N 061947; 10-port, P/N 061948) has the
correct number of ports for the valve being serviced.

7. Align the slots in the new pod with the runner in the valve holder on the
Dionex 1CS-1100 (see Figure 5-6). Valve pods are keyed to fit only one way
(one slot is narrower than the other). Verify that the slots are aligned with their
matching runners.

8. Also verify that the two splines on the pod align with the matching splines
inside the valve holder (see Figure 5-6). If necessary, twist the end of the pod
to adjust the position of the splines.

Valve Pod Valve Holder

Splines

Figure 5-6. Valve Pod and Pod Holder
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9. Push the pod into the holder until it clicks into place. Replace the black
locking ring.

10. Reconnect all liquid lines to the valve.

11. Turn on the pump flow. Check for leaks from the valve. Tighten fittings as

required (see Section 5.1.1).
12. Close the door.
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5.6 Cleaning and Replacing the Pump Check Valves

A dirty check valve causes erratic flow rates and pressures. In addition, it
may cause the pump to lose prime and/or be difficult to reprime. If possible,
replace dirty check valves. If new check valves are not available, follow the
instructions for cleaning.

Replacing Check Valves

1. Close the eluent valve from the Dionex ICS-1100 Control panel in
Chromeleon.
2. Turn off the main power switch, to ensure that you do not unintentionally start
the Dionex 1CS-1100.
3. To prevent contamination of pump parts, put on a pair of rubber gloves before
disassembling the pump head.
4. Disconnect the tube fittings from the inlet and outlet check valve assemblies
on the primary pump head (see Figure 5-7).
5. Use a 1/2-inch wrench to loosen both check valve assemblies. Remove the
check valve assemblies from the pump head.
_ Outlet Check
| Valve
Primary
Secondary
Pump Head Pump Head

Acorn Nuts

Inlet Check
Valve

Figure 5-7. Pump Heads

NOTE The inlet check valve assembly housing has a 1/4-28 port.
The outlet check valve assembly housing has a 10-32 port.
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6.

If you are installing new cartridges
(P/N 045994) in the existing check valve Double-hole Single-hole
housings, place the cartridge in the inlet
check valve housing with the double-hole
end of the cartridge visible and place the
cartridge in the outlet housing with the
single-hole end visible.

Outlet
Check

‘ Valve '

NOTE The pump will not operate
properly unless the cartridge is
installed in the housing in the
correct orientation. Liquid flows
through the check valve in the
large single hole and out the
small double holes.

Install the inlet check valve assembly (P/N 045722) on the bottom of the
primary pump head. Install the outlet check valve assembly (P/N 045721) on
the top of the head. Tighten the check valves fingertight, and then use a
wrench to tighten an additional one-quarter to one-half turn.

IMPORTANT Overtightening may damage the pump head and check valve housing
and crush the check valve seats.

10.
11.

Reconnect the liquid lines. Turn on the Dionex ICS-1100 main power.

Open the eluent valve from the Dionex 1CS-1100 Control panel in
Chromeleon.

Prime the pump (see Section 5.17).

When the Dionex ICS-1100 is at operating pressure, check for leaks from the
check valves. Tighten a check valve a little more only if it leaks.

Cleaning Check Valves

1.
2.

Carefully remove the check valve cartridges from the valve housings.

Place the check valve housings and cartridges in a beaker with methanol.
Sonicate or agitate the parts for several minutes.

Rinse each check valve housing and cartridge thoroughly with filtered
deionized water.

To reinstall the check valves and complete the procedure, see Step 6 through
Step 11 above.
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5.7 Re

placing a Pump Piston Seal and Piston Rinse Seal

A damaged seal allows leakage past the piston, as well as leakage from the
piston seal wash housing. The pump may be difficult to prime, flow rates may
be unstable, and there may be baseline noise.

Preparation

1.

Rinse the pump flow path with deionized water. Direct the flow to waste by
opening the waste valve on the secondary pump head (see Figure 5-10). To
open the valve, turn the knob one-quarter to one-half turn counterclockwise.

After rinsing, close the waste valve.

Close the eluent valve from the Dionex 1CS-1100 Control panel in
Chromeleon.

To prevent contamination of pump parts, put on a pair of rubber gloves before
disassembling the pump head.

Removing the Head and Piston

1.

Turn off the main power switch, to ensure that you do not unintentionally start
the Dionex 1CS-1100.

2. Disconnect all tubing connections to the pump head.

3. Locate the open-end wrench (P/N 014605) provided in the Dionex 1CS-1100
Ship Kit (P/N 057905). Use the wrench to remove the two acorn nuts (see
Figure 5-7) from the pump head.

4. Slowly pull the head and allow it to separate from the housing. Carefully
disengage the head from the piston by pulling the head straight off and away
from its mounting studs.

Lateral motion while disengaging the pump head from the piston may
break the piston.

CAUTION
Un mouvement latéral pendant la séparation de la téte et du piston
peut casser le piston.
Vermeiden Sie Seitwértsbewegungen, wenn Sie den Kopf vom Kolben
I6sen. Andernfalls kann der Kolben brechen.

VORSICHT
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5. Place the head (front end down) on a clean work surface and lift off the spacer
to expose the piston seal (see Figure 5-8 or Figure 5-9).

Priming Valve Knob £
(PIN 055709) ’433%
Outlet Check 'ﬁ‘) ')

Valve Assembly
(P/N 045721)
@ O-Ring
(P/N 055752)

Piston Seal
(P/N 055870)

Spacer with Drain
(P/N 057913) Primary Pump Head

(PIN 055711)

Piston Rinse Seal \
(PIN 048722) ® O-Ring
® (P/N 014895)

@ O-Ring % Inlet Check

Valve Assembly

(P/N 059283) ‘
\ Seal Guide J (P/N 045722)

Piston (P/N 058032)
(PIN 052840)

Figure 5-8. Primary Pump Head

Waste Valve Knob

(PIN 055710) A<
N7
5%

L~ O-Ring
(PIN 055752)

Piston Seal
(P/N 055870)

Secondary
Pump Head
(P/N 055712)

Spacer with Drain
(P/N 057913)

Piston Rinse Seal \
(P/N 048722) O-Ring
(P/N 014895)
Seal Guide
(P/N 058032) O-Ring
(P/N 059283)

(PIN 052840)

Figure 5-9. Secondary Pump Head
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6. The piston does not come off as part of the pump head assembly because it is
captured by a magnetic retention system. After removing the pump head, hold
the shaft of the piston (near the base), tilt the piston slightly, and pull the
piston away from the pump.

Installing the New Piston Rinse Seal

1. Remove the guide from the spacer to expose the piston rinse seal and O-ring.
Remove the O-ring.

2. Remove the old piston rinse seal from the guide as follows:

a. Hold the guide with the flat side facing up.

b. To dislodge the piston rinse seal,
gently insert the shaft of the piston
through the small hole in the center
of the guide (see photo).

c. Pull the seal off the end of the
piston shaft and remove the piston
from the guide.

3. Hold the new piston rinse seal
(P/N 048722) with the grooved side
facing up.

4. Using your fingertip, gently press the piston rinse seal into the guide until the
edge of the seal is below the surface of the guide.

The piston rinse seal is made of soft plastic. Do not press on the seal

with anything hard or sharp, including your fingernail. If the seal is

nicked or gouged, it will not seal properly and may result in leaks.

5. Place the new O-ring (P/N 059283) into the groove in the guide.

6. Remove the O-ring from the groove in the flat side of the spacer and replace it
with the new O-ring (P/N 014895).

7. Inone hand, hold the guide with the O-ring and piston rinse seal facing up
(this prevents the O-ring from falling out). In the other hand, hold the spacer
with the cavity facing down.

8. Gently press the guide into the cavity in the spacer until it is fully seated.
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Removing the Piston Seal from the Head

1.

6.

Fill the head cavity with deionized water by injecting the liquid through either
the piston opening or the inlet check valve.

Reinsert the piston approximately 3 mm (0.125) inch into the seal.

If this is the primary pump head, install a 10-32 fitting plug (P/N 042772) on
the outlet check valve. Tighten the plug.

If this is the secondary pump head, install a 10-32 fitting plug (P/N 042772)
in both the inlet and outlet ports. Tighten the plugs.

Push the piston into the head. (This should hydraulically unseat the seal from
the head.) Remove the piston and pull off the seal.

NOTE If the piston seal is not removed, make sure the 10-32
fitting plug(s) are tight and add more water. Make sure
the head contains no air bubbles, and then repeat Step 2

and Step 5.
Remove the 10-32 fitting plug(s).

Installing the New Piston Seal

1.

3.

4.

Open the priming valve knob (primary pump head) or waste valve knob
(secondary pump head) by turning the knob one-quarter to one-half turn
counterclockwise.

Push the piston through the spacer and then through the new seal. Insert the
piston and seal into the pump head until the seal makes contact with the
bottom of the counterbore.

NOTE If necessary, lubricate the seal with a small amount of
isopropyl alcohol to facilitate insertion.

To seat the seal, push down on the spacer until it is flush with the head. A
clicking sound indicates that the seal is correctly seated.

Close the priming valve knob or waste valve knob.
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Reinstalling the Head and Piston

Thermo Fisher Scientific recommends reinstalling the head and piston as a single
assembly, so that the piston centers itself onto the magnetic follower.

1.

Hold the assembled spacer and guide with the drain tubes aligned vertically
and press the spacer into the head until it is flush with the indented surface of
the head.

Insert the piston so that 1/4 inch of the shaft is exposed. This ensures that the
magnet in the follower picks up the piston. (The follower is the cylinder that
holds the piston in place as it moves in and out of the pump head assembly.)

Reinstall the head and piston assembly; use a wrench to tighten the nuts
evenly (12 in-Ib torque).

Completing the Procedure

1.

2
3.
4

Reconnect all liquid lines to the pump head.
Turn on the main power switch.
Open the eluent valve.

Prime the pump (see Section 5.17).

5.8 Replacing a Pump Piston

Continued leaking of the piston seal after installation of a new seal (assuming
the pump head is tight) indicates a dirty, scratched, or broken piston.

Follow the instructions in Section 5.7 to install a new piston (P/N 052840) and
piston seal (P/N 055870).
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5.9 Replacing the Waste Valve or Priming Valve O-Ring

A damaged O-ring causes leakage around the base of the waste valve or
priming valve knob.

1. Close the eluent valve from the Dionex 1CS-1100 Control panel in
Chromeleon.

2. Turn off the main power switch, to ensure that you do not unintentionally start
the Dionex 1CS-1100.

3. To remove the waste valve or priming valve from the pump head (see
Figure 5-10), turn the knob counterclockwise until it is loose, and then pull
the knob straight out of the cavity in the pump head.

Waste Vaive —— @

"4
. &

Figure 5-10. Waste and Priming Valves
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4. If the O-ring is removed with the valve knob in Step 3, pull the O-ring off the
end of the knob (see Figure 5-11). If the O-ring is not removed with the valve
knob, insert a thin object (for example, the bent end of a paper clip) into the
cavity in the pump head and carefully pull out the O-ring. Do not scratch the
cavity.

IMPORTANT Scr'atches in the_ cav_lty W|I_I cause leaks around the base of the knob
while the pump is being primed.

@ el Valve Knob

O-Ring
(P/N 055752)

Figure 5-11. Waste Valve or Priming Valve O-Ring Replacement

5. Slide a new O-ring (P/N 055752) over the end of the valve.
6. To reinstall the valve containing the new O-ring, turn the knob clockwise and
then tighten fingertight.
NOTE It is normal to encounter resistance after several

rotations of the knob; the O-ring is being pushed

into the cavity of the pump head.
7. Turn on the main power switch.
8. Open the eluent valve.
9. Prime the pump (see Section 5.17).
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5.10 Replacing the Conductivity Cell

Turn off the Dionex 1CS-1100 powver.

Open the front door and disconnect the tubing from the CELL IN and CELL
ouT fittings (see Figure 5-12, View A). Loosen the two screws on the cell

front cover. The screws remain attached (see Figure 5-12, View B).

Unscrew
SCIENTIFIC

DS6 HEATED CONDUCTIVITY ceu ;

SerIALNO. [ ,
CELLCONSTANT [ ]

CELL IN

CELL OUT

Unscrew

~ View B

Figure 5-12. Removing the Cell Front Cover

Grip the two loosened screws
and pull the cell cover toward
you to remove it from the
component panel. Do not pull
from the CELL IN and CELL
OuT fittings.

Continue pulling on the cover
until the attached cell assembly
slides out the front of the
Dionex 1CS-1100 (see

Figure 5-13).
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5. Slide the new cell assembly straight into the opening in the component panel
until it stops and the cell cover is flush against the component panel. The
cell’s electronic connector automatically plugs into a connector inside the
Dionex ICS-1100 when you push the assembly into the opening.

© © N o

Tighten the screws on the cell front cover fingertight.
Close the side panel door and tighten the two mounting screws.
Reconnect the inlet and outlet lines.

Turn on the Dionex 1CS-1100 power.

10. Calibrate the new cell in Chromeleon. Calibration of a new cell consists of
three parts:

e

o

Running the offset calibration, which measures the output of the cell
electronics alone and determines an offset value to be applied to raw
conductivity readings.

Running the slope calibration, which measures the output of the cell
electronics when a built-in dummy cell, which provides a constant
conductivity reading of 21 uS, is automatically enabled. The slope value
is applied to raw conductivity readings.

Entering the cell constant measured at the factory. The Dionex 1CS-1100
uses the cell constant to determine the measured conductivity.

Open the Wellness Panel (see Section 5.1.1)
Under Electric Conductivity Cell Calibration, click Offset Cal.
When the offset calibration is complete, click Slope Cal.

Click Calibration Details. Under Conductivity Cell Cal Details, enter
the Cell Constant value printed on the front of the cell.

In the field next to the Download button, verify that Current is selected
and then click Download to download the new value to the Dionex ICS-
1100.

To ensure that the new values are recorded in the Dionex ICS-1100
memory, do not turn off the Dionex ICS-1100 power for at least 1 minute
after downloading.
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5.11 Replacing the Suppressor

Refer to the suppressor manual for guidance about when to replace a suppressor.
Suppressor manuals are included on the Thermo Scientific Reference Library
DVD (P/N 053891).

1. Refer to the suppressor quick start guide (shipped with the suppressor) for
instructions on preparing the suppressor before initial use and for additional
installation details.

Turn off the pump from the Dionex 1CS-1100 Control panel in Chromeleon.
Open the front door of the Dionex 1CS-1100.
Disconnect the two eluent and the two regenerant lines from the suppressor.

o~ DN

To remove the suppressor from the component panel, slide it up to detach it
from the mounting tabs on the panel and then pull it toward you.

6. Continue pulling the
suppressor out until the
yellow connector on the
cable inside the Dionex ICS-
1100 is outside the panel (see

Figure 5-14).

7. Disconnect the suppressor
cable (twist the ring on the
yellow connector and pull the |
two connectors apart).

‘‘‘‘‘
-t

Yellow
Connector

e

Figure 5-14. Removing the Suppressor

8. Connect the cable from the new suppressor to the Dionex 1CS-1100 cable
(align the pins on the two connectors and push them together).

9. Orient the suppressor with the REGEN OUT fitting on top and the cables to the
right.

10. Push the cables into the opening in the component panel.
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11.

12.

13.

14.

Align the top of the suppressor
with the guide line printed on the
component panel (see

Figure 5-15) and align the slots
on the rear of the suppressor
with the tabs on the panel.

Press the suppressor onto the
tabs and then slide it down until
it locks into place. Pull slightly
on the center of the suppressor to
verify that it is securely fastened.
Note: Some suppressors require
more force to secure them onto
the tabs.

Connect the two eluent and two
regenerant lines to the new
suppressor.

Close the Dionex ICS-1100 front
door.

Suppressor
Mounting Tabs

Suppressor
Cable Connector

Guideline for
AES

Guideline for
SRS

Figure 5-15. Suppressor Guidelines and Mounting

Tabs on Component Panel

5.12 Replacing the Column Heater

Turn off the Dionex 1CS-1100 power.
Open the front door of the Dionex 1CS-1100.

Remove the existing column heater:

a. Unscrew the two thumbscrews on the heater cover (they remain attached

to the cover).

b. Pull the heater cover straight out to remove it.
c. Unscrew the six thumbscrews on the top metal plate (see Figure 5-16) and

remove the plate.
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Thumbscrews (6)

Figure 5-16. Dionex ICS-1100 Column Heater Cover Removed

d. Remove the columns from the column heater.

e. Pull the column heater straight toward you to remove it from the
component panel.

4. Before installing the new column heater, write down the two calibration
values (offset and slope) recorded on the back of the heater.

5. Align the connector on the back of the new column heater (P/N 069564) with
the connector on the component panel (see Figure 2-4) and push the column
heater onto the component panel.

6. Remove the heater cover and the metal plate on the new heater.

7. Install the columns in the new heater and replace the top metal plate and
heater cover.

8. Turn on the Dionex ICS-1100 power.

9. Enter the column heater calibration values in Chromeleon as follows.
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a. Open the Wellness Panel (see Section 5.1.1) and click Calibration
Details.

b. Under Column Heater Calibration Values, enter the Column Heater
Offset and Column Heater Slope values recorded in Step 4.

c. Inthe field next to the Download button, verify that Current is selected
and then click Download to download the new calibration values to the
Dionex 1CS-1100.

d. To ensure the new calibration values are recorded in the Dionex 1CS-1100
memory, do not turn off the Dionex ICS-1100 power for at least 1 minute
after downloading the values.

5.13 Replacing the Column Heater Heat Exchanger

1. Turn off the Dionex 1CS-1100
power.

2. Open the front door of the Thumbscrews
Dionex 1CS-1100. ®
Heat
3. Unscrew the two thumbscrews | Exchanger
on the column heater cover Screws (3)
(they remain attached to the

cover).

4. Pull the heater cover straight
out to remove it.

5. Unscrew the six thumbscrews
on the top metal plate (see

Figure 5-17) and remove the
plate.

6. Disconnect the heat exchanger
inlet line from port C on the
injection valve.

Figure 5-17. Dionex ICS-1100 Column Heater Cover
Removed
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10.

11.

Disconnect the heat exchanger outlet line from the guard column inlet.

Use an Allen wrench to remove the three screws from the heat exchanger
metal plate and remove the plate (with the tubing) from the heater.

Remove the plastic backing from the new heat exchanger (P/N 059979, with
0.25-mm (0.010-in) ID tubing; P/N 060943, with 0.125-mm (0.005-in) 1D
tubing) and press the heat exchanger onto the heater. Replace the screws
removed in Step 8.

Connect the new heat exchanger inlet line to port C on the injection valve and
connect the outlet line to the guard column inlet.

Reinstall the top metal plate and the heater cover.

5.14 Replacing the Eluent Valve

1.
2.
3.

Turn off the power to the Dionex ICS-1100.
Open the Dionex I1CS-1100 front door.

To prevent an eluent leak during the valve replacement procedure, disconnect
the eluent line from the reservoir cap or plug the line on the left side of the
valve with a coupler (P/N 039056) and a plug (P/N 037268) after you
disconnect the liquid line from the valve in Step 4.

Disconnect the two liquid
lines connected to the
eluent valve (see

Figure 5-18).

Unscrew and remove the
two screws that attach the | Disconnect
valve to the component

panel (see Figure 5-18).

Save the screws.

Remove

Figure 5-18. Eluent Valve
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6. Pull the valve straight out from the
component panel and begin pulling
the attached cable out of the opening
in the panel.

7. The cable is connected to a
matching cable inside the Dionex
ICS-1100. Continue pulling until the ;
connectors for the two cables are Eluent Valve
outside the panel (see Figure 5-19).
Disconnect the cables.

8. Remove the mounting plate on the
old valve by unscrewing and
removing the two screws. Save the
SCrews.

Remove
screws

9. Thread the cable from the new
eluent valve through the mounting
plate.

10. Attach the mounting plate to the
new valve using the screws
removed in Step 8.

Figure 5-20. Removing the Eluent Valve Mounting Plate

11. Connect the cable from the new valve (P/N 057945) to the Dionex ICS-1100
cable. Feed the cables back inside the Dionex 1CS-1100.
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12.

13.
14.

Align the new valve on the component panel with the liquid ports facing up
and attach it with the two screws removed in Step 5. Reconnect the liquid
lines.

Turn on the power to the Dionex 1CS-1100.
Prime the pump (see Section 5.17).

5.15 Replacing the Leak Sensor

1.

Turn off the power to the
Dionex ICS-1100.

Open the Dionex ICS-1100
front door.

Loosen the screw on the front of |
the leak sensor (see

Figure 5-21). Note: The screw
remains attached to the sensor.

Figure 5-21. Leak Sensor

Remove the leak sensor from

the component panel and pull

the cable out of the opening in
the panel.

The cable attached to the leak
sensor is connected to a
matching cable inside the
Dionex ICS-1100. Continue
pulling the cable until the
connectors for the two cables
are outside of the panel (see

Figure 5-22).

Disconnect the two cables.

Figure 5-22. Leak Sensor Cable
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7. Connect the cable from the new leak sensor (P/N 058053) to the Dionex ICS-
1100 cable.

8. Feed the cables back inside the Dionex 1CS-1100. Align the leak sensor with
the component panel opening and fingertighten the screw.

9. Make sure the leak sensor does not touch the bottom of the drip tray.

5.16 Priming the Pump

1. Verify that the eluent reservoir is filled, the reservoir cap is installed and hand
tightened, and the liquid line from the Dionex 1CS-1100 to the reservoir cap is
connected.

2. Verify that the waste lines are directed to a waste container.
3. The priming procedure consists of two parts:

* Priming the eluent lines with a syringe (see Section 5.16.1). Perform this
procedure at initial installation, after changing eluents, or when eluent
lines are empty.

= Priming the pump heads with the Prime button (see Section 5.16.2).
Perform this procedure after the eluent lines are primed.

5.16.1 Priming the Eluent Lines with a Syringe

NOTE Prime the eluent lines after initial installation, after
changing eluents, or when eluent lines are empty.
1. Verify that the pump is turned off.

2. Connect a 10 mL syringe (P/N 079803) to the priming valve port on
the primary pump head (see Figure 5-23).
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Secondary
Pump Head

Waste Valve
(close)

Primary
Pump Head

10 mL Syringe Priming Valve
(P/N 079803) (open)

Figure 5-23. Priming the Eluent Lines

Open the priming valve by turning it one-quarter to one-half turn
counterclockwise.

On the Dionex ICS-1100 Control panel in Chromeleon, click the
Pump Settings button. The Pump Settings window opens (see
Figure 3-5).

Under Eluent Flow Valve, click the Open button.

Draw the syringe back to begin pulling eluent through the flow path.
It may take several syringe draws to remove all air or previous eluent
from the tubing.

NOTE If the vacuum degas assembly is installed, draw
out an additional 20 mL of eluent.

After priming the lines thoroughly, close the priming valve. Do not
overtighten.
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5.16.2 Priming with the Prime Button

NOTE Perform this procedure after priming the eluent
lines (see Section 5.16.1).

1. Check that the priming valve on the primary pump head is closed (see

Figure 5-24).

Secondary
Pump Head

Waste Valve
(open)

Primary
e Pump Head
Priming Valve

(close)

Figure 5-24. Priming the Pump

2. Open the waste valve on the secondary pump head by turning the
knob one-quarter to one-half turn counterclockwise (see Figure 5-24).
Opening the valve directs the eluent flow path to waste and eliminates
backpressure.

3. Inthe Pump Settings window (see Figure 3-5), click the Prime
button. Confirm that the waste valve is open by clicking OK when the
reminder message appears. The pump will begin pumping at about
3 mL/min.

4. Continue priming the Dionex ICS-1100 until no air bubbles are
exiting the pump waste line.

5. In the Pump Settings window, click Pump Off.

6. Close the waste valve. Do not overtighten the valve.
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5.17 Priming the Pump with Isopropyl Alcohol

NOTE Prime the pump heads with isopropyl alcohol only if the
two standard priming procedures described in
Section 5.16 are unsuccessful.

Connect a 10 mL syringe
(P/N 079803) filled with
isopropyl alcohol (IPA) to
the port in the primary
pump head (see

Figure 5-25).

Open the waste valve on
the secondary pump head
(see Figure 5-25) by
turning the knob one-
quarter to one-half turn
counterclockwise.

Secondary
Pump Head

Waste Valve
(open)

Primary
Pump Head

10 mL Syringe Priming Valve

(P/N 079803) (open)

Figure 5-25. Priming the Pump Heads with IPA

In the Pump Settings window (see Figure 3-5), click Pump On.

Open the priming valve on the primary pump head by turning it one-quarter to
one-half turn counterclockwise.

Use the syringe to slowly push alcohol through the pump.

NOTE Be careful not to push any air trapped in the syringe
through the pump. Check the waste line from the
secondary pump head to verify that there are no air

bubbles.

Close the priming valve. Do not overtighten. Disconnect the syringe from

the priming valve.

Let the pump run for several minutes, to purge alcohol from the pump heads.
Then, click the Prime button in the Pump Settings window to flush the heads

with the desired eluent.
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IMPORTANT Isopropyl alcohol may damage some columns. Be sure to thoroughly

rinse the alcohol from the pump, using the process described in
Step 7.

8. Close the waste valve. Do not overtighten.

9. Select the flow rate required for the analysis.

10.

5.18 Ch

In the Pump Settings window, click Pump Off.

anging Main Power Fuses

1. Turn off the main power switch.

>

ACHTUNG

2.

HIGH VOLTAGE—Disconnect the main power cord from its source and
also from the rear panel of the Dionex ICS-1100.

HAUTE TENSION—Débranchez le cordon d'alimentation principal de
sa source et du panneau arriere du Dionex ICS-1100.

HOCHSPANNUNG—Ziehen Sie das Netzkabel aus der Steckdose und
der Netzbuchse auf der Riickseite des Dionex ICS-1100.

The fuse holder is part of the main power receptacle (see Figure 5-26) on the
Dionex ICS-1100 rear panel. To remove the fuse holder, squeeze the tab on
the top of the holder to release it and pull the holder straight out of its
compartment.

Main Power
Receptacle

Fuses (2)

=¥

Fuse Holder
Fuse Holder (Side View)

Figure 5-26. Main Power Fuse Holder
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3. Replace the two fuses in the holder with new IEC 127 fast-blow fuses rated
3.15 amps (P/N 954745). Thermo Fisher Scientific recommends always
replacing both fuses.

4. Reinsert the fuse holder into its compartment and push in until the tab clicks
in place.

5. Reconnect the main power cord and turn on the power.

118 Doc. 065289-03 10/12



A < Specifications

A.1 Electrical

Main Power 100 to 240 Vac, 50 to 60 Hz (Auto-sensing power supply; no
manual voltage or frequency adjustment required)

Fuses Two 3.15 amp fast-blow IEC 127 fuses (P/N 954745)

A.2 Physical

Dimensions Height: 56.1 cm (22.1 in)
(Without  Width: 22.4 cm (8.8 in)
reservoir) Depth: 53.3 cm (21.0 in)

Weight  24.5 kg (54 Ib)
Decibel Level <52 dBA

Control Modes Full control through front panel and Chromeleon software;
alternative control through TTL or relay closure (two relay outputs,
two TTL outputs, four programmable inputs)

USB One USB input; one built-in USB hub with two outputs
Communication
Protocol
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A.3 Environmental

Operating
Temperature

Operating
Humidity

Operating Pressure

A.4 Front Panel

Power LED

Inject Valve
LEDs

Alarm LED

Status LEDs

4 t0 40 °C (40 to 104 °F); cold room-compatible (4 °C) as long
as system power remains on

5% to 95% relative humidity, noncondensing

35 MPa (5000 psi) maximum liquid path (tubing, valve,
columns, etc.)

On when power is present; off when no power is present

Indicates the injection valve position.

Indicates an alarm state.

Indicates the instrument status.

A.5 Analytical Pump and Fluidics

Type

Construction

Operating
Pressure

Flow Rate
Range

Flow Precision

Flow Accuracy

Serial dual-reciprocating pistons, microprocessor-controlled
constant stroke, variable speed

Chemically inert, metal-free PEEK pump heads and flow paths
compatible with aqueous eluents of pH 0 to 14 and reversed-phase
solvents

0 to 35 MPa (0 to 5000 psi)

0.00 to 5.00 mL/min in 0.01 mL/min increments without changing
pump heads

<0.1% typical

<0.1% typical
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Pressure Ripple

Eluent On/Off
Valve

Piston Seal
Wash

Pressure Alarm
Limits
Vacuum Degas

Eluent Bottles

Eluent Bottle
Pressure

Leak Detection

<1% at 13.8 MPa (2000 psi) and 1.0 mL/min

Standard feature

Dual-pump head; wash can be continuous when connected to rinse
solution supply

e Upper limit: 0 to 35 MPa or 0 to 5000 psi in one unit (MPa or
psi) increments

* Lower limit: Up to one unit lower than upper limit
Optional feature; automatic control
Polypropylene

Not required

Built-in optical sensor

Doc. 065289-03 10/12
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A.6 Eluent Regeneration

Eluent
Regeneration

Eluents

Flow Rates

Continuous
Operation
(4 L of Eluent)

Always On/
Always Ready
Capable

Remains Fully
Calibrated for
Extended Periods
(<28 days)
System Wellness
Maximum
Operating
Pressure
Operating
Temperature
Range

Optional feature; RFIC-ER Startup Kit required

e Carbonate and carbonate/bicarbonate up to 20 mM

® MSAupto34mM
0.01 to 2.00 mL/min
Up to 28 days or 2000 samples, typically

Standard feature

Standard feature; results are traceable to a single cal

ibration

Consumables usage monitoring for predictive maintenance

21 MPa (3000 psi)

4 t0 40 °C (40 to 104 °F)

A.7 Detector Electronics

Type
Cell Drive

Detector
Linearity

Resolution

Microprocessor-controlled digital signal processor
8 kHz square wave

1% uptolmS

0.00238 nS/cm
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Full-Scale
Output Ranges

Electronic Noise

Filter

Temperature
Compensation

Temperature
Range

Temperature
Stability

e Digital signal range: 0 to 15,000 pS
* Analog signal range: 0 to 15,000 uS

+0.1 nS/cm when background conductivity is 0 to 150 uS/cm
+2 nS/cm when background conductivity is 151 to 3200 uS/cm

Rise times from 0 to 10 s; user-selectable

Fixed at 1.7% per 1 °C at cell temperature

Ambient +7 °C; 30 to 55 °C

<0.01°C

A.8 Conductivity Cell with Heat Exchanger

Cell Body

Cell Electrodes
Cell Volume
Maximum Cell
Operating
Pressure

Heat Exchanger
Operating

Temperature

A.9

Chemically inert polymeric material
Passivated 316 stainless steel; compatible with MSA
<luL

10 MPa (1500 psi)

Inert, tortuous path for low axial dispersion

30 to 55 °C (86 to 130 °F); must be at least 7 °C above the ambient
temperature

Injection Valve

Injection Valve 6-port, 2-position Rheodyne valve with PEEK wetted components;

electrically-activated
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A.10 Auxiliary Valve (Optional)

Auxiliary Valve  6-port or 10-port, 2-position Rheodyne valve with PEEK wetted
components; electrically-activated

A.11 Vacuum Degas Assembly (Optional)

Channel Single-channel degas channel with degas membranes
Pump Dual-stage diaphragm vacuum pump
Materials Wetted materials, PEEK, PTFE

A.12 Column Heater (Optional)

Operating 30to 60 °C (86 to 140 °F); minimum 5 °C above ambient
Temperature temperature. Settable range is equal to working range.

Temperature 0.5 °C at sensor
Stability
Temperature 0.5 °C at sensor, at 40 °C
Accuracy

Maximum 250 mm analytical column with 50 mm guard column
Column Lengths
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A.13 Suppressors

Chemical
Suppression

Displacement
Chemical
Regeneration

Electrolytic
Suppression

Current Control
Range

Salt Converter
Dionex AMMS
ICE™

Carbonic Acid
Removal for
Anions

Non-Suppressed

Suppressor Wear
Parts

Suppression
Capacity

2 mm and 4 mm anion and cation, membrane suppression bed types

2 mm and 4 mm anion and cation, membrane suppression bed types

® Self-Regenerating: 2 mm and 4 mm anion and cation; both
membrane and MonoDisk ™ suppression bed types available

* Self-Regenerating with External Water Mode: 2 mm and
4 mm anion and cation; both membrane and MonoDisk
suppression bed types available

SRS (4 mm): 0 to 300 mA in 1 mA increments
SRS (2 mm): 0 to 100 mA in 1 mA increments
AES: 0to 150 mA in 1 mA increments

CMD: 0 to 500 mA in 1 mA increments

SRN: 0 to 500 mA in 1 mA increments

2 mm and 4 mm versions available
2 mm and 4 mm versions available

ASRS™ 300 with CRD 200 for hydroxide eluents
ASRS 300 with CRD 300 for carbonate eluents

Supported
None; peristaltic pump and inline filters not required

Anion SRS 300 (4 mm): 200 peg/min
Cation SRS 300 (4 mm): 110 peg/min
Anion SRS 300 (2 mm): 50 peg/min
Cation SRS 300 (2 mm): 37.5 peg/min
Anion MMS 300 (4 mm): 150 peg/min
Cation MMS 300 (4 mm): 150 peg/min
Anion MMS 300 (2 mm): 37.5 peg/min
Cation MMS 300 (2 mm): 37.5 peg/min
Anion AES: 25 peg/min

Cation AES: 25 peg/min
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Void Volume

SRS 300 (4 mm): <50 pL

SRS 300 (2 mm): <15 pL

MMS 300 (4 mm): <50 pL

MMS 300 (2 mm): <15 pL
AMMS ICE 300 (4 mm): <50 uL
AMMS ICE 300 (2 mm): <15 uL
Anion AES: <35 puL

Cation AES: <35 uL

A.14 Autosampler

Automation
Using
Autosampler
Sequential/
Simultaneous
Injection

Automated
Dilution

Online Sample
Degassing

Online Filtration

Automation
Flexibility

Dionex AS, Dionex AS-AP, Dionex AS-DV, or Dionex AS-HV
Autosampler (or third-party autosampler)

May be available; depends on autosampler capabilities

Available with a Dionex AS Autosampler

* Dilution Factor: 1:1 to 1:1000

* Dilution Time: 15 seconds with sample overlap
Optional; CRD 200/300 required

Available with a Dionex AS-DV Autosampler or an inline filter
High, using Chromeleon software and post-run features

A.15 System Software

Software

Automated
Procedure
Wizards

System Wellness
and Predictive
Performance

Chromeleon Chromatography Management System or Chromeleon

Xpress; validated for use with Windows Vista or Windows XP
Standard feature

Standard feature
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Data Trending
Plots

Virtual Column
Simulator

Application
Templates

Automation
Support for
Third-Party

Vendors

3D Software for
PDA, MS,
and ED

Customizable
System Control
Panels

System Status
Virtual Channels

Power Failure
Protection

Sequential
Injection

System Trigger
Commands and
Conditionals

Daily Audit Trail

Sample Audit
Trail

Multiple
Network Control
and Network
Failure
Protection

Storage of
System
Calibration
Settings

Numerical device parameters can be plotted

* Evaluation mode: Standard feature
* Isocratic and gradient modes: Optional features
Standard feature

Fully controls over 300 different instruments from more than 30
manufacturers, including GC, HPLC, and MS

Optional feature

Standard feature

Standard feature
Standard feature
Standard feature
Standard feature
Standard feature
Standard feature

Optional feature

Factory, current, and previous calibration values are stored; the user

can reset current values to factory or previous values
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Customized Standard feature; unlimited report workbooks
Reporting

Automated Detailed, comprehensive qualification reports
System
Quialification
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B.1 TTL and Relay Connections

A 12-pin connector strip for TTL/relay control is located on the Dionex 1CS-1100
rear panel. The connector provides two relay outputs, two TTL outputs, and four

TTL inputs (see Figure B-1).

Connector
Pin Function Position Description
— O] 12
1 Solid State Relay Contacts Output
RELAY @ 2 }
outr 3
2 Solid State Relay Contacts Output
4 '7 y p
TTL OUT 1 @ 5 TTL Output 1 (1 kQ pull up to +5, 100 mA sink)
) 2 6 TTL Output 2 (1 kQ pull up to +5, 100 mA sink)
1 @ 7 TTL Input 1 — Inject/Load
TTLIN 2 8 TTL Input 2 — Autozero
*) 3 @ 9 TTL Input 3— Pump/Suppressor On
1 10 TTL Input 4 — Mark
TTL GND 1 11 Ground Note: The TTL input
0 functions can be reassigned
2 @ 12 Ground to different inputs.

Figure B-1. TTL and Relay Connector on Rear Panel

IMPORTANT| Relay loads in excess of 200 mA or with included power supplies over

60 V may damage the relay drivers on the CPU.

NOTE TTL 1 Input - Inject/Load applies only to the injection

valve (not to the auxiliary valve, if installed).
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The outputs can be used to control functions in external devices such as an
autosampler or another Dionex module. When connected to a controlling device,
the inputs can be programmed to perform the following Dionex 1CS-1100
functions:

= Switch the injection valve position (load/inject)
e Perform an autozero command (set the conductivity to zero)
e Turn the pump on and off (also turns the suppressor on and off)

= Send a chart mark signal to the analog output. The mark is 10% of the full-
scale voltage, and the duration is 0.5 seconds. A mark can be used, for
example, to indicate the injection.

Relay outputs 1 and 2 can be programmed to switch any low-voltage control.
Switched current must be less than 200 mA and 42 V peak.

Connecting a TTL or Relay

1. Locate the twisted pair of
wires (P/N 043598) and the
12-position connector plug Position 1
(P/N 923687) (see

Figure B-2) in the Dionex
ICS-1100 Ship Kit (P/N

Locking
Screws

057905) Position 12
2. Follow these basic steps to
connect the TTL or relays. Figure B-2. 12-Position Connector Plug

a. Foreachrelayor TTL to
be used, connect an active wire (red) and a ground wire (black) to the 12-
position connector plug at the appropriate pin locations. Refer to
Figure B-1 or the label on the Dionex ICS-1100 rear panel for the
connector pin assignments.

To attach a wire to the plug, strip the end of the wire, insert it into the
plug, and use a screwdriver to tighten the locking screw. If necessary,
multiple ground wires can be attached to a single TTL input/output
ground pin.

When attaching wires to the connector plug, be careful not to allow

IMPORTANT| stray strands of wire to short to the adjoining position on the

connector.
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b. Plug the connector into the 12-pin connector on the Dionex 1CS-1100 rear
panel.

c. Connect the wires from the Dionex 1CS-1100 connector plug to the TTL
or relay connector pins on the other module(s). Additional connector
plugs are provided with other Dionex modules.

NOTE Check the polarity of each connection. Connect
signal wires to signal (+) pins and ground wires to
ground (-) pins.

3. If you connected a TTL input, verify that the correct function is assigned to
the input and that the correct input control type is selected. Select different
settings, if necessary. Input functions and control types are assigned from
Chromeleon (see Section B.1.1).
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B.1.1 Selecting TTL Input Functions and Control Types

To select TTL input functions and the control type, open the Chromeleon
Server Configuration program and double-click the Dionex ICS-1100
icon under the timebase. Select the TTL Inputs tab (see Figure B-3).

Dionex ICS-1100 IC System X

Solvents | StateDevices | InjectValve | EnmorLevels | DemoChiomatogram |
Genersl | Options | Signals |  HeadTypetLimits |
TTL Inputs | Trend |  Calbation | Diagnosties |
TTL Input Mode: Nomaledoe |
TTL Input Funclions

TTL Input 1: | Load/Inject Valve |
TTL Input 2 | Autozero |
TTL Input 3: iPurnpfSuppwessor ON/OFF Ll
TTL Input 4: | Recorder mark |
[ ok ] concel | | Hew |

Figure B-3. Dionex ICS-1100 Server Configuration Properties: TTL Inputs

TTL Input Control Types

The Dionex ICS-1100 TTL inputs respond to four types
Hornal BilEa of signals to accommodate different controlling devices.
nverted Edge | The default control type, Normal Edge, is compatible
mverted Pulse | with the output signals provided by Dionex modules.

If the device connected to the Dionex 1CS-1100 does not send a normal
edge signal, select the appropriate control type. Refer to the
documentation provided with the controlling device and the information
below to select the correct type.
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Normal Edge: In normal edge Action Off or No Effect
operation, the negative (falling) . R

edge of a signal turns on the NORJ;'[

function. For example, for the EDGE gy —
Load/Inject function, the Adklon OR

negative edge switches the
injection valve position to Load.

The action of the positive (rising) edge depends on the function: For
the Load/Inject function, the rising edge switches the injection valve
to the Inject position. For the Pump On function, the rising edge turns
off the pump (and suppressor). For Autozero and Mark, the rising
edge has no effect.

Inverted Edge: The inverted Action On

edge mode works identically to S5V e, ¥

the normal edge mode except .NVERTTE'[;

that the positive and negative EDGE g v ...

edges are reversed in function. Action Off :,Pr No Effect

Normal Pulse: In normal pulse
operation, the negative (falling) —_
edge of the TTL signal is the Hofnar

active edge and the positive o
(rising) edge is ignored.

Action On Action Off

A pulse width of 50 ms or more

is guaranteed to be detected. A pulse width of 4 ms or less is
guaranteed to be ignored. The action for pulse widths that are greater
than 4 ms and less than 50 ms is undefined.

Inverted Pulse: The inverted

pulse mode operates identically ASHENQ SRR
to the normal pulse mode TTL*S V

except that the positive and k1L oy

negative edges are reversed in

function.
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B.2 Controlling TTL and Relay Outputs

The Dionex ICS-1100 provides two TTL outputs and two relay contacts for
control of functions in external devices, such as an integrator or autosampler. The
relay outputs can be used to switch any low-voltage control. Switched current
must be less than 200 mA and 60 V peak blocking. The relay-contact closures are
normally open. When the relay is closed, current flows to the connected device.

IMPORTANT| Relay loads in excess of 200 mA or with included power supplies over

60 V may damage the relay drivers on the CPU.

The TTL outputs are normally at 5 volts. Setting a TTL output to 0 volts turns on
the action in the connected device.

The TTL and relay output states can be controlled, either by issuing direct control
commands from the Chromeleon Control panel or by including the commands in a
control program.
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Part Number

046548
039164

057937
057938
045721
045722
045994
052840
055870
048722
055752
057945
079803

042857
057968
024305
016388
057896

069472
069473
057896

Item

Reservoirs
2-L plastic reservoir assembly (includes stopper and cap)
4-L plastic reservoir assembly (includes stopper and cap)

Pump
Primary pump head assembly
Secondary pump head assembly
Outlet check valve assembly, 10-32
Inlet check valve assembly, 1/4-28
Check valve cartridges
Piston
Piston seal
Piston rinse seal
O-ring for waste valve or priming valve
Eluent valve
10 mL syringe (for priming eluent lines)

Sample Loop and Injection Valve
25-uL sample loop
Injection valve
Luer adapter fitting, 1/4-28 (for manual injections)
1-mL syringe (for manual injections)
Injection Valve Rebuild Kit

Auxiliary Valve
Auxiliary Valve Kit (6-port valve)
Auxiliary Valve Kit (10-port valve)

Injection Valve Rebuild Kit (for use with auxiliary valve, also)
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Part Number
061947
061948

056116
056118
064554
064556
064555
064557
057985
069564
059979
060943

079910
052324

923686
043598

069570
067791
069569
067792
070061

954745
060494
060392

Item
Auxiliary valve pod assembly (6-port valve)
Auxiliary valve pod assembly (10-port valve)

Suppressors, Cell, and Column Heater
Dionex AAES Anion Atlas Electrolytic Suppressor
Dionex CAES Cation Atlas Electrolytic Suppressor
Dionex ASRS 300 4-mm Anion Self-Regenerating Suppressor
Dionex CSRS 300 4-mm Cation Self-Regenerating Suppressor
Dionex ASRS 300 2-mm Anion Self-Regenerating Suppressor
Dionex CSRS 300 2-mm Cation Self-Regenerating Suppressor
Dionex DS6 heated conductivity cell
Column heater assembly
Column heater heat exchanger, 0.25-mm (0.010-in) ID tubing

Column heater heat exchanger, 0.125-mm (0.005-in) ID tubing (for
use with 2-mm columns)

Column heater cover assembly
Microbore tubing kit

Relay/TTL
12-position connector plug
Twisted pair of wires

RFIC-ER Kits
RFIC-ER Anion Startup Kit, ICS-1100/ICS-1600
RFIC-ER Anion Consumables Kit, ICS-1100/ICS-1600
RFIC-ER Cation Startup Kit, ICS-1100/ICS-1600
RFIC-ER Cation Consumables Kit, ICS-1100/ICS-1600
ER Tubing Kit

Miscellaneous
IEC 127 fast-blow fuses, rated 3.15 amps
USB cable, 5 m (16 ft)
External USB hub
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Part Number Item

Preventive Maintenance Kits
057954 Dionex ICS-1100 Preventive Maintenance Kit
060581 Dionex AS Preventive Maintenance Kit
055647 Dionex AS-DV Preventive Maintenance Kit
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D + FAQ

D.1

D.2

D.3

D.4

D.5

How do | hook up an autosampler?

For instructions on how to connect the Dionex 1CS-1100 to an autosampler, refer
to the Dionex ICS-1100 installation instructions. Also refer to the autosampler
operator’s manuals, which are included on the Thermo Scientific Reference
Library DVD (P/N 053891).

How do I print?

Click the Print toolbar button in Chromeleon.

Why are the retention times moving?

Retention times can shift if the pump flow is erratic or if the column or eluent is
contaminated. See Section 4.7 for pump flow rate troubleshooting. If a
contaminated column is suspected, clean the column as instructed in the column
manual. The column manual is included on the Thermo Scientific Reference
Library DVD (P/N 053891).

How do | adjust retention times?

Retention times are calculated during calibration. The Use Recently Detected
Retention Time parameter in the Chromeleon QNT Editor (General tab) can be
used to compensate for some types of retention time drifts; for example,
evaporation of volatile components in pre-mixed solvents or an aging column.
Refer to the Chromeleon Help or user’s manual for details.

When should | remake standards?

Standards are used only for calibration and should always be made fresh (they
have a lifetime of only one week).
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D.6 When should | remake eluents?
Eluents should be remade every two or three weeks.

D.7 How do | start Chromeleon?
Click Start on the Windows taskbar, and then select All Programs >
Chromeleon > Chromeleon.

D.8 How do | delete data?
In the Chromeleon Browser, highlight the sequence you want to delete and then
select File > Delete.

D.9 How do | back up data?
In Chromeleon, select File > Export/Backup. Back up the data and indicate the
backup source.

D.10 How do | shut off the system?
In Chromeleon, click the System Shutdown button on the Dionex ICS-1100
Control panel. On the instrument, turn off the power switch on the rear panel (see
Figure 2-6).

D.11 How do | store columns?
Columns should be stored in eluent. See the column manual for complete
instructions. The column manual is included on the Thermo Scientific Reference
Library DVD (P/N 053891).

D.12 How do | know when a column is dirty?
See the troubleshooting section of the column manual.
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D.13 How do I clean a column?

See the troubleshooting section of the column manual.

D.14 Why is the conductivity high?

Possible reasons for high conductivity include:

e The suppressor is not on. Turn on the suppressor from the Chromeleon
Control panel.

= The suppressor needs regeneration. See the suppressor manual for
troubleshooting information. The suppressor manual is included on the
Thermo Scientific Reference Library DVD (P/N 053891).

e The cell is out of calibration. See Section 5.1.2 for calibration instructions.

e See Section 4.13 for additional troubleshooting information.

D.15 How do | configure and operate the auxiliary valve?

See Installing the 1CS-1100/1CS-1600/1CS-2100 Auxiliary Valve (Document No.
065288), provided in the Auxiliary Valve Kit.
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Analytical Column
Synonymous with Separator Column.

Band Spreading

The broadening of the sample band as it travels through the column. Band
spreading can also occur in the injection valve, detector cell, and interconnecting
tubing.

Calibration Curve
A graph showing detector response in peak height or area versus analyte
concentration.

Capacity Factor (k")

The number of column volumes of eluent, pumped through the column, required
to elute an analyte. Capacity factor is a dimensionless measure of retention which
is independent of column length or eluent flow rate. It is calculated as follows:

Where: t, = retention time
t, = retention time of unretained solute (column void volume)
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Cell Constant (k)
A factor determined experimentally by measuring the conductance (G) of a
standard solution of known equivalent conductivity (k).

k = /G

The value of k depends upon the surface area of, and distance between, the
electrode faces in the conductivity detector cell.

k =1/A

Where: | = length
A = area of one electrode (the other electrode is equal to
the first)

Channeling
The preferential flow of liquid along more open, less resistant paths through the
column packing. This causes Band Spreading.

Column Efficiency (N)

A measure of the narrowness of analyte bands as they elute from the column.
High efficiency is desirable because resolution between closely spaced bands
improves with greater efficiency. For a symmetrical (Gaussian) peak, column
efficiency can be determined by the following:

N = 5.54(t;/W;,5)?

Where: t; = the peak retention time (in seconds)
W/, = the peak width at 1/2 height (in seconds)

Column efficiency is proportional to column length: for a given resin and column
diameter, increasing the column length increases the column efficiency.
Synonymous with Theoretical Plates.

Column Selectivity (a)
Describes the relative separation of the band maxima between two adjacent peaks.
Selectivity can be determined by the following:

a = (tz - to)/(ty -to)

Where: t; and t, = retention time of components 1 and 2, respectively
to = retention time of unretained components (void volume)

Concentrator Column
A short column used to retain and concentrate analytes from a measured volume

144
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of relatively clean sample. This allows large volumes of sample to be injected,
lowering concentration detection limits.

Conductivity

A measure of the ease with which electrical current flows through a liquid
contained between two opposite charged electrodes. Conductivity is a
characteristic of ions in solution. Units are siemens.

Counterion
lons carrying a charge opposite that of the sample ions (e.g., Na*) may be the
counterion of a CI” analyte. These ions preserve electrical neutrality in solution.

% Crosslink

Divinylbenzene content in a polystyrene/divinylbenzene (PS-DVB) resin; this
contributes to the mechanical strength of the resin and determines
chromatographic properties.

Equivalent Conductivity (1)

The contribution of an ionic species to the total conductivity of a solution as
measured in a standard cell having electrodes 1 cm? in area and exactly 1 cm
apart.

Guard Column

A small column that prevents poisoning of the separator column by sorbing
organic contaminants and removing particulates. It is filled with the same packing
as the separator column. Synonymous with Pre-Column.

HETP (H)
Height Equivalent to a Theoretical Plate. A measure of column efficiency which
allows comparison between columns of different lengths.

HETP =H = LIN

Where: L = the column length (in mm)
N = the number of theoretical plates

lon-Exchange Capacity
The number of active ion exchange sites in a given weight or volume of resin; this
is usually expressed in meqg/g or meg/mL.

lon-Exchange Resin
An insoluble polymer matrix containing fixed-charge exchange sites (anionic or
cationic). IC resins are formed into small spherical particles (beads).
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Packing
The material that fills a chromatographic column; usually a resin or silica-based
material.

Pellicular Resin

A resin with a solid, nonporous core coated with a thin layer of more porous
material. The exchange sites of pellicular ion exchange resins are located only on
the surface layer of the bead. These resins have a low ion-exchange capacity.

Pre-Column
Synonymous with Guard Column.

Regenerant
A dilute acid or base that converts ion exchange sites in a MicroMembrane
Suppressor back to the form that suppresses the eluent conductivity.

Resin
See lon-Exchange Resin.

Resolution (R)

A measure of the separation between two sample components. This is expressed
as the ratio of the distance between the two peak maxima to the mean value of the
peak width at the baseline.

R=2(t; - ty)/(W5 + W)

Where: t; and t, =the retention times of components 1 and 2,
respectively
W, and W, = the baseline width of peaks 1 and 2,
respectively (measured in the same units as the retention
time)

R is proportional to the square root of efficiency (N). A value of R=1.5
represents “baseline separation” of the two peaks.

Retention Time
The time from injection to peak maximum; the basis for identification of a species
in chromatographic analysis.

Separator Column
The column used to perform a chromatographic separation; also called an
analytical column.
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Siemens (S)
Unit measure of conductance; the reciprocal of the electrical resistance of a
solution.

Suppressor
A device used to minimize eluent conductivity and convert sample species to a
common form, thus increasing detection sensitivity.

Temperature Coefficient

The percent of change in the conductivity of a solution with a 1 °C change in
temperature. Every solution has a characteristic temperature coefficient which is
determined experimentally.

Theoretical Plates (N)
See Column Efficiency.

Void Volume (V)

The volume occupied by the eluent in a packed column. This volume includes the
volume between the injection valve and the column, as well as between the
column and the detector cell. Unretained components are eluted in the void
volume.
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A

Air particulate samples, 48
Alarm conditions, 61 — 67
See also Error messages
Ambient temperature, 78
Analog output, 130
Connector, 18
Anion separations, 47
Application Wizard, 54
AS Autosampler, 49
Maintenance, yearly, 56
Sample injection, 51
AS-DV Autosampler, 49
Maintenance, yearly, 57
Sample injection, 51
AS-HV Autosampler, 49
Atlas Electrolytic Suppressor, 16
See also Suppressor
Audit Trail
Error messages, 59
Icons, 59
Autosampler
Loading samples with, 51
See also AS Autosampler
See also AS-DV Autosampler
Autosampler Control panel, 25
Autosampler specifications
Automated dilution, 126
Automation, 126
Automation flexibility, 126
Online filtration, 126
Online sample degassing, 126
Semiautomated system qualification, 126
Sequential/Simultaneous injection, 126
Autozero, 46, 52
Auxiliary valve, 15, 32, 49
Applications, 32
Configuration, 49

Does not switch position, 65

Installation instructions, 32

Leaking, 69

Maintenance, yearly, 56

Passages blocked, 74

Rebuilding, 91

Reordering, 135

Replacing the mechanical part (pod), 91 -
92

Troubleshooting, 65

B

Background conductivity
High, 76
Offsetting, 46
Backpressure, 30
Restriction in plumbing, 87
Troubleshooting, 73
Baseline
Drift, 78
Noise, 20, 22, 78
Stability, 34
Batch processing, 38
Blockages
Liquid lines, 64, 87
Bottle
See Reservoir

C

Cables

Power cord, 117
Calibration, 81

Conductivity cell, 84

Flow rate, 86

Vacuum degas assembly, 87
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Cation separations, 47
Cell
See Conductivity cell
Cell calibration, 84
Check valves
Cleaning procedure, 95 — 96
Replacement procedure, 95 — 96
Chromatogram, 3
Chromeleon, 24
Alarm conditions, 61
Application Wizard, 54
Audit Trail, 59
Audit Trail error messages, 59
Commands, 53
Degas options, 79
Error messages, 61
Interface, 24
Overview, 24
Panel tabset, 24
Programs, 51
Quantification method, 55
Starting, 40
Timebase, 24
Wellness panel, 81
Chromeleon Server
Starting, 40
Chromeleon Server Monitor, 40
Column heater, 16, 33
Replacement procedure, 107
Specifications, 124
Column heater alarms
Column heater exceeds safe temperature,
61
Column heater open circuit, 61
Column heater short circuit, 61
Columns, 16
Cleaning, 140 - 141
Contaminated, 76
Damage from IPA, 117
Storing, 140
Component panel, 14
Conductivity
Causes of high conductivity, 141
Temperature effect, 34

Conductivity cell, 15, 34
Calibrating, 84
Calibration constant, 105
High cell output, 76
Leaking, 69
No response, 76
Replacement procedure, 104
Volume, 34
Conductivity cell specifications
Active volume, 123
Cell body, 123
Chemical compatibility, 123
Electrodes, 123
Maximum pressure, 123
Temperature, 123
Contacting Thermo Fisher Scientific, 8
Contamination
Column, 74, 76
Eluents, 75
Sample, 76
Standard, 74
Control panel (Chromeleon), 24
Autosampler, 25
Sequence Control, 25
Status, 25

D

Daily maintenance, 55
Data

Backing up, 140

Deleting, 140

Saving, 53
Data analysis description, 3
Decibel level, 119
Default panel tabset, 25
Degas tubing assembly

See Vacuum degas assembly
Degas calibration failed alarm, 61
Degassing eluents, 26, 42
Detection description, 3
Detector specifications

Auto offset, 122
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Calibration, 122
Cell drive, 122
Control and data evaluation, 122
Linearity, 122
Range, 122
Resolution, 122
Temperature compensation, 122
Diagnostics, 81
Dimensions, 119
Dionex, 40
Direct software control, 25
Drip tray, 15
DS6 Heated Conductivity Cell
See Conductivity cell
Duty cycle, 27

E

Electrical specifications

Fuses, 119

Main power, 119
Eluent

Aqueous, 56, 71

Degassing, 26

Delivery process, 2

Filtering, 43

Preparing, 42

When to remake, 140
Eluent bottle

See Eluent reservoir
Eluent level, 43
Eluent reservoir

Connecting, 44

Monitoring liquid level in, 43

Storage on top cover, 13
Eluent valve, 16

Replacing, 110
End-line filter

See Filter, end-line
Environmental specifications, 120
Equilibration time, 46
ER Controller (ERC 10), 17, 35
Error messages, 61 — 67

Audit Trail description, 59

Column heater exceeds safe temperature,

61
Column heater open circuit, 61
Column heater short circuit, 61
Degas calibration failed, 61
Hardware not present, 62
Leak sensor wet, 62
Load/inject valve error, 62
Option not installed, 63
Pump motor lost control, 63
Pump over pressure, 64
Pump pressure hardware error, 64
Pump stopped due to lost USB
communication, 64
Pump under pressure, 65
Second valve error, 65
Suppressor not connected, 66
Suppressor over current, 66
Suppressor over power, 67

Suppressor stopped for zero flow rate, 67

F

Filter, end-line
Bacterial contamination, 56, 71
Dirty or clogged, 56, 71
Installation, 43

Fittings
Leaking, 68
Replacing, 90
Requirements, 90

Flow rate, 15, 120
Calibration, 86
Troubleshooting, 72

Flow schematics, 20

Front panel, 11

Fuses
Replacement procedure, 117
Requirements, 119

Doc. 065289-03 10/12

Index-3



Dionex ICS-1100 lon Chromatography System

G

Ghosting, 74
Guard column, 16

H

Hardware not present error, 62
Heater, column, 33

See also Column heater
High pressure alarm, 64
Humidity, operating, 120

Injecting samples, 49

Via autosampler, 51

Via syringe, 50

Via vacuum syringe, 51
Injection port, 11

Injecting via syringe, 50
Injection valve, 15, 30

Leaking, 69

Passages blocked, 74

Plumbing connections, 31

Rebuilding, 91

Specifications, 123

Troubleshooting, 62
Installation

Priming, 113, 115

TTL and relay connections, 129 — 130
Inverted edge TTL input control, 133
Inverted pulse TTL input control, 133
lon chromatography overview, 1
lon exchange, 3
Isocratic delivery system, 2
Isopropyl alcohol, 116 — 117

L

Leak sensor, 15
Leak sensor wet alarm, 62

Replacement, 112
Leaks
Auxiliary valve, 69
Cell, 69
Fittings, 68
Injection valve, 69
Liquid, 68
Pressure transducer, 69
Pump check valve, 68
Pump head, 68
Pump head waste valve, 69
Pump piston seal, 68
Suppressor, 69
LED, 120
Linearity requirements, 122
Liquid leaks, 68
See also Leaks
Load/inject valve alarm, 62
Loading samples, 49
Loop
See Sample loop

M

Main power receptacle, 19
Maintenance, 55

Daily, 55

Ongoing, 55

Weekly, 56

Yearly, 56
Manual sample processing, 38
MicroMembrane Suppressor, 16

See also Suppressor
Moduleware, 59

N

Nitrite in samples, 48
Normal edge TTL input control, 133
Normal pulse TTL input control, 133
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O PGM file
See Programs

Offsetting background conductivity, 46 Physical specifications

Operating features, 11 Deci
. L ecibel level, 119
Operating humidity, 120 Dimensions. 119
Operating ranges Weiaht 119
Cell heater, 15 : 19,
Col heater 16 Piston seals
olumn heater, Replacement procedure, 97 — 98
Flow rate, 15 Pistons
Operating temperature, 120 Replacement procedure, 101
Operation - ’
R Plumbing
Equilibration time, 46 Injection valve, 92
Overview, 37 j

Replacing tubing and fittings, 90
Troubleshooting, 87

Plumbing diagrams, 20

Power
Turning on, 39

Power cord, 117

Power receptacle, 19

Power requirements, 119

Power-up conditions, 39

Priming, 45, 115 - 116

Reservoir setup, 42

Sample preparation, 47

Sample processing, 38

Setting operating conditions, 46

Starting Chromeleon, 40

System power-up, 39
Operational status verification, 46
Option not installed error, 63

Pressure
Oven Limit, 65
Se_e Column heater System, 65
Overview of system, 4 Pressure transducer, 15, 30
Leaking, 69
System backpressure, 30
P Priming, 45, 113, 115 - 116
Panel tabset, 24 Pump is out of prime, 71
How to display, 25 With a syringe, 113
Panels With isopropyl alcohol, 116
Chromeleon Wellness panel, 81 With the Prime button, 115
Component panel, 14 Priming valve
Parameters Opening, 28
Chromeleon operating commands, 53 O-ring replacement procedure, 102
Peak ghosting, 74 Printing, 139
Peak height Problems
Reproducibility, 34 See Troubleshooting
Troubleshooting, 75 Processing samples, 38, 52 — 53
Peaks Automatically (batch), 38, 53 — 54
Extraneous (ghosting), 74 Manually, 38, 52
PEEK Product warranty, 81, 91 — 92
Conductivity cell body, 34 Programmed software control, 25

Doc. 065289-03 10/12 Index-5



Dionex ICS-1100 lon Chromatography System

Programs (Chromeleon), 25
Controlling an autosampler, 51
Pulse damper, 20, 22, 30
Pump, 28
Flow rate, 15
Leaks, 68
Over pressure alarm, 64
Primary pump head, 28
Priming, 45, 113
Priming problems, 70
Secondary pump head, 29

Stopped due to lost USB communication,

64

Troubleshooting, 72

Under pressure alarm, 65
Pump check valve leaking, 68
Pump degas

See Vacuum degas assembly
Pump head waste valve

Leaking, 69

O-ring replacement procedure, 102
Pump heads, 95
Pump motor lost control alarm, 63
Pump pressure hardware error, 64
Pump priming valve

O-ring replacement procedure, 102
Pump specifications

Construction, 120

Delay volume, 120

Eluent bottle pressure, 120

Eluent generation, 120

Flow accuracy, 120

Flow precision, 120

Flow rate, 120

Gradient capabilities, 120

Operating pressure, 120

Pressure ripple, 120

Type, 120

Vacuum degasser, 120

Q

Quantification method, 55

R

Rear panel, 18

Analog output connector, 18

Power receptacle, 19

USB connections, 19
Rebuilding the auxiliary valve, 91
Rebuilding the injection valve, 91
Relay connections

Rear panel connector, 19, 129
Relay outputs

Controlling, 134

Voltage and current specifications, 130

Reordering information, 135
Reproducibility, 34
Reservoir
Connecting, 44
Monitoring liquid level in, 43
Storage on top cover, 13
Restriction in liquid lines, 64, 87
Retention time
Adjusting, 139
Moving, 139
Troubleshooting, 75
RFIC-ER compartment, 17
RFIC-ER Kits, 17
RFIC-ER mode
Components required, 17
Flow schematics, 20
Specifications, 122
Running samples, 52
See also Processing samples

S

Safety messages, 6
Sample loop, 15, 30 — 31
Changing, 90
Injecting, 31
Injection valve connections, 31, 91
Loading, 31
Reordering, 135
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Sample processing, 38, 52 — 53
Batch, 38, 53
Manual, 38, 52
With Chromeleon, 52 — 53

Samples
Collecting and storing, 47
Diluting, 48
Filtering, 47
Injecting, 49, 51
Loading, 49
Pretreating, 48

Saving data, 53

Schematics, 20

Seal replacement, 98

Second valve
Troubleshooting, 65

Second valve error, 65

Selectivity
Troubleshooting, 75

Self-Regenerating Suppressor, 16
See also Suppressor

Separation process, 3

Separator column, 16

Sequence Control panel, 25

Sequence Wizard, 55

Server Configuration program
Starting, 40

Service chase, 13, 16

Service procedures, 96
Check valve cleaning, 95 - 96
Check valve replacement, 95
Conductivity cell replacement, 104
Fuse replacement, 117
Injection valve rebuilding, 91
Isolation of liquid lines restriction, 87
Leak sensor replacement, 112
Piston replacement, 101
Piston seal replacement, 97
Priming valve O-ring replacement, 102
Rebuilding the auxiliary valve, 91
Rebuilding the injection valve, 91
Replacing tubing and fittings, 90
Suppressor replacement, 106
Tubing and fittings replacement, 89

Waste valve O-ring replacement, 102
Software control, 24
Modes of, 25
Software specifications
Application templates, 126
Automated procedure wizards, 126
Automation support for third-party
vendors, 126
Customizable system control panels, 126
Customized reporting, 127
Daily Audit Trail, 126
Multiple network control, 127
Network failure protection, 127
Power failure protection, 126
Sample Audit Trail, 126
Sequential injection, 126
Storage of calibration settings, 127
System status virtual channels, 126
System trigger commands and
conditionals, 126
System Wellness and Predictive
Performance, 126
Virtual column simulator, 126
Specifications
Autosampler, 126
Column heater, 124
Conductivity cell, 123
Detector, 122
Electrical, 119
Environmental, 120
Injection valve, 123
Physical, 119
Pump, 120
Supressors, 125
System software, 126
Vacuum degas assembly, 124
Standards
When to remake, 139
Status Control panel, 25
Sulfite in samples, 48
Suppression description, 3
Suppressor
Description, 16, 34
Leaking, 69

Doc. 065289-03 10/12

Index-7



Dionex ICS-1100 lon Chromatography System

Replacement procedure, 106
Suppressor alarms
Suppressor not connected, 66
Suppressor over current, 66
Suppressor over power, 67
Suppressor stopped for zero flow rate, 67
Supressor specifications
Chemical suppression, 125
Displacement chemical regeneration, 125
Electrolytic suppression, 125
Sequential suppression for anions, 125
Suppression capacity, 125
Suppressor wear parts, 125
Void volume, 125
Syringe injection, 50
Vacuum, 51
System
Shutdown, 140
Startup, 39
Status, 46
System backpressure, 30
System components
Descriptions, 26
System overview, 4
System Wellness, 25

T

Technical Support, 8, 59, 81
Temperature
Cell heater, 34
Column heater, 16, 33
Minimizing the effect of variations, 34
Temperature compensation, 34
Temperature, operating, 120
Thermo Fisher Scientific
Contacting, 8
Thermo Fisher Scientific Technical Support, 8,
59, 81
Timebase, 24
Top cover, 13
Troubleshooting, 59
Alarm conditions, 61

Baseline noise or drift, 78
Calibrations, 81
Diagnostics, 81
Error messages, 61
Excessive backpressure, 73
Flow rate, 72
High cell output, 76
Liquid leaks, 68
No cell response, 76
Peak ghosting, 74
Peak height, 75
Pump, 70 - 72
Retention time, 75
Selectivity, 75
Vacuum degas assembly, 79
TTL and relay connector, 129
Connection instructions, 130
Pin assignments, 129
TTL inputs
Default function assignments, 130
Rear panel connector, 19
TTL outputs
Controlling, 134
Rear panel connector, 19
Tubing
Replacing, 90
Requirements, 90
Routing clips, 19
Tubing connections
Isolating a restriction, 64, 87

U

USB connections, 19

\Y

Vacuum degas assembly, 26
Calibration, 87
Components, 26
Fails to run, 79
Specifications, 124
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Troubleshooting, 70
Valve

See Auxiliary valve

See Eluent valve

See Injection valve

See Waste valve

W

Warranty, voiding, 81, 91 — 92
Waste lines

Blocked, 68
Waste valve, 29

Opening, 29, 97

O-ring replacement procedure, 102
Water samples, 48
Weekly maintenance, 56
Weight, 119
Wellness, 25
Wellness panel, 81

Y

Yearly maintenance, 56
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